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Windows Cluster Environment Installation (V5.2.3 - 5.2.5)

You may follow different installation and upgrade scenarios when you install and
upgrade IBM® Sterling B2B Integrator in a Windows Cluster (multiple node)

environment.

Installation Scenarios for Version 5.2.3 - 5.2.5.x.

It is important to review the following installation scenarios:

Scenario

Instructions

Version 5.2.0 - 5.2.2 is installed as the base
release and it needs to be upgraded to the
5.2.3 level.

Use the Install Version 5.2.x as a Fix Pack
instructions provided in Install the Software.

Version 5.2.3 is being installed as the base
release.

Review this document and use the
installation instructions in Install the Software.

Version 5.2.3 is installed as the base release
and it needs to be upgraded to a later 5.2.x

Use the Install Version 5.2.x as a Fix Pack
instructions provided in Install the Software.

level.

Installation Overview

Prerequisite Knowledge for Windows Installation
Before you being the installation, you should be knowledgeable on the following
topics:
* Application servers
 Database administration

* System Requirements for this release of Sterling B2B Integrator.

Intended audience
This document can be used by different members of your organization.

This document is intended for use by:
* System administrators

* Installation engineers

* Database administrators.

Assumptions for this guide

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Prepare Your System for Installation

Before You Begin the Installation in a Windows Environment
Before you begin the installation, you need to:
* Perform some system verification tasks

© Copyright IBM Corp. 2000, 2015 1



Download the correct version of the JDKs, JCE, and JDBC drivers required. See
the System Requirements for information on how to download the correct version
of each.

System Verification Tasks for a Windows Environment
Before you begin an installation, you need to:

#

System Verification Items Your Notes

Use the system requirements to verify that your
system hardware and software meet the
requirements specified for this release.

Verify you have the correct:

* Patches required by Java™ for the operation
system

e Version of the JDK
» Absolute path to JDK and patches

Verify the file system has adequate free disk space.

Verify that your database has been installed and
configured.

If you are going to manually apply DDL
statements, you need to complete the data base
schema work before you begin the installation.

If you are using a non-English environment,
confirm that you are using the appropriate
character set.

Verification of the system requirements

Before you begin the installation, verify that your system meets the hardware and
software requirements that are specified for this release.

The hardware requirements that are listed in the System Requirements are the
minimum requirements. Your system requirements exceed these requirements if
you are running other applications on the same machine as Sterling B2B Integrator.

The installation strictly enforces the following system requirements:

If

Operating system version must match requirement exactly.

The minimum patch level for the operating system is enforced, but you can
apply higher patch levels.

JDK version must match requirement exactly.

The disk space is a minimum for the installation. The system must be separately
sized to handle whatever load is going to be put on the system.

Database version must match exactly.
JDBC driver version supports exact matches and wildcard matches.

any of these requirements are not met, the installation fails. If the installation

fails, review the installation log for a list of noncompliant items.

2 Windows Cluster Environment Installation:




Configure the Database

Supported Database Servers in a Windows Cluster
Environment

In a windows cluster environment, the Sterling B2B Integrator can support the
following databases:

+ Oracle®
 DB2

* Microsoft SQL Server - In this document, where ever Microsoft SQL Server
(MSSQL) is mentioned, it applies to both 2005 and 2008 depending on which
version you have installed. If the information is specific to one version or the
other version, the version is specifically stated.

Only a non-clustered installation can use the MySQL database. See System
Requirements for supported version information.

You must install, create, and configure a database so that each Sterling B2B
Integrator instance has a dedicated schema and login for the database.

Required database information before you install Sterling B2B
Integrator in a cluster environment

Before you begin to install Sterling B2B Integrator, you need to install and
configure your database.

Review and gather the following information. An x indicates that the information
is required.

Microsoft
SQL Record Information
Information to Gather Oracle DB2° Server Here
Application Instance Host
Application Instance Port
Database User Name X X X
Database Password X X X
Database Catalog Name X X X
Database Host X X X
Database Port X X X
JDBC Driver #1 X X X
Use BLOB data? X X
Enable Multibyte Support? X X X

Database sizing and capacity planning

Database sizing is designed to give you estimates of the database growth and to
help you plan the disk requirements.

There are many factors to consider when you are estimating the amount of disk
space that is required for Sterling B2B Integrator. As a result, trying to consider all
growth factors is impractical because the user might not know the answers to
many questions that are required to do a detailed forecast. Over the years the cost
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of disks has dramatically decreased, and the capacity and speed of disks has
increased. The method of how information system managers order disk capacity
also has changed, from purchasing disk arrays that are dedicated to a particular
database server and project, to the concept of SANS (storage area networks).

Sterling B2B Integrator provides a way to estimate your initial disk requirements.
Consider the confidence that you have in your data estimates when you are
making the final purchase decision and adjust accordingly. After the initial
purchase and production deployment, disk growth should be tracked for future
purchase forecasts.

You should track your actual database storage usage and the number of database
records regularly. Correlating these two metrics enabled you to plan your future
disk requirements. Moreover, determining the average amount of space used for
each order line or shipment line, enables you to accurately predict your future
growth requirements.

Database Definition Language (DDL) Statements

When you install Sterling B2B Integrator, you can manually apply Database
Definition Language (DDL) statements to your database tables instead of requiring
the installation process to do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Configure the DB2 Database

DB2 database configuration checklist
Before you install Sterling B2B Integrator with the DB2 database, you must
configure the database.

Before you begin:

* If you do not have DB2 installed, follow the procedures in the DB2 installation
manual.

* The installation script creates tables and indexes. Certain tables require a page
size of 32 KB. You must have a temporary table space to accommodate such
tables. DB2 automatically places tables and indexes in the available table spaces.
You can move the tables to a different table space after the installation is
complete.

* If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve the data, either back up the existing database or save it
under a different name.

* After you create and configure your database, recycle the database. Then, stop
and restart the database to apply the changes.

Use the following checklist to configure DB2 for Sterling B2B Integrator:
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Item DB2 Database Configuration Checklist Your Notes

1 Create the database.

Refer to the DB2 documentation on creating the
database, including creating a schema repository,
login, and table space.

Be sure to install the correct version and patches.
See the System Requirements for supported
version information.

2 Install the client components, compilers, and fix
pack.

Review the DB2 parameters.

4 Ensure that the DB2 user privileges are set.
Install the JDBC drivers for DB2.

DB2 database user privileges
The DBADM role is required to perform administrative operations in DB2
database.

DB2 parameters

When you install Sterling B2B Integrator with the DB2 database, you must set
certain DB2 parameters. Other DB2 parameter settings are recommended for the
efficient performance of Sterling B2B Integrator.

When you install Sterling B2B Integrator with DB2, you must set the DB2
parameters that are listed in the following topics:

* [“Mandatory settings for IBM DB2 registry variables”|

+ [“Mandatory settings for DB CFG parameters” on page 6|

After you install Sterling B2B Integrator with DB2, you can improve the DB2
database performance by setting the recommended parameters that are listed in the
performance documentation for the following items:

* DB2 registry variables

* DBM CFG parameters

* DB CFG parameters

- DB29.7

« DB2 for Linux on System z® (5.2.4.0 or later)
* DB2 for LUW configuration and monitoring

Mandatory settings for IBM DB2 registry variables:

Mandatory IBM DB2 registry values are critical for IBM DB2 performance with
Sterling B2B Integrator.

Windows Cluster Environment Installation (V5.2.3 - 52.5) 5



Variable Mandatory value

DB2_SKIPDELETED ON

Allows index-range queries or table-scan queries to skip
records that are in an uncommitted delete state. This
reduces the amount of lock contention from Read Share
and Next Key Share locks from range queries in tables
with a high frequency of deletes.

When enabled, DB2_SKIPDELETED allows, where
possible, table or index access scans to defer or avoid
row locking until a data record is known to satisfy
predicate evaluation. This allows predicate evaluation
to occur on uncommitted data.

This variable is applicable only to statements using
either Cursor Stability or Read Stability isolation levels.
For index scans, the index must be a type-2 index.
Deleted rows are skipped unconditionally on table scan
access while deleted keys are not skipped for type-2
index scans unless DB2_SKIPDELETED is also set.

Recommended value: ON

DB2_SKIPINSERTED ON

Allows SELECTs with Cursor Stability or Read Stability
isolation levels to skip uncommitted inserted rows. This
reduces record lock contention on tables with heavy
insert rates.

Mandatory settings for DB CFG parameters:

For optimal performance, certain parameters and values are mandatory for DB2
9.x.

Parameter Mandatory value

Database Code Set UTE-8

Installing DB2 client components, compilers, and fix pack
The use of Sterling B2B Integrator with the DB2 database requires the installation
of different items for the database.

About this task

Sterling B2B Integrator uses stored procedures for DB2. For more information
about these tasks, see the IBM documentation for DB2.

Procedure

You must install or set up the following DB2 components to use Sterling B2B
Integrator with DB2:

1. Install the Administration client.

2. Install the necessary fix pack after you install the client components and
compilers. Otherwise, the clients overwrite the fix pack binary files.

3. Set the path for the compiler by entering the db2set command.
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Installing JDBC drivers for DB2
When you install Sterling B2B Integrator with the DB2 database, you must install a
JDBC driver for the database.

About this task

For DB2, install the appropriate DB2 JDBC Type 4 driver and any correlating
patches. For the supported version information, see Systerm Requirements.

You can obtain these files from the IBM website. After you obtain this JDBC driver,
record the absolute path to its location on your system. You must supply this
absolute path during installation.

If the JDBC driver provided by your database vendor is distributed among
multiple files, you must place all the files that comprise the JDBC driver into one
JAR file. Follow these steps to create one JAR file:

Procedure

To install a JDBC driver for the DB2 database:
1. Identify all the vendor database JAR files for the JDBC driver.

2. Record the absolute path to the JAR file you created on the Preinstallation
Checklist.

The Type 4 driver does not require a separate Java' listener to be running on
the database server. Instead, connect directly to the DB2 port.

Upgrading DB2 to version 10.1
To upgrade from DB2 9.5 or 9.7 to 10.1, you must make configuration changes.
DB2 version 10.1 is only supported on Sterling B2B Integrator 5.2.4.1_2 or higher.

Procedure

To upgrade from DB2 9.5 or 9.7 to 10.1:
1. Copy your DB2 9.5 or 9.7 database content to DB2 10.1.
Attention: Back up all files before you change any settings.

2. Back up the database driver in the /install_dir/dbjar/jdbc/DB2/ directory
and replace it with the DB2 10.1 version.

3. Update the following sandbox.cfg file fields with your environment-specific
parameters:

DB_PASS=
DB_SCHEMA_OWNER=
DB_DRIVERS_VERSION=
YANTRA_DB_PORT=
DB_DATA=
DB_HOST=
YANTRA_DB_USER=
DB_PORT=
YANTRA_DB_PASS=
YANTRA_DB_DATA=
YANTRA_DB_HOST=
DB_DRIVERS=
DB_USER=

DB2_PORT=
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DB2_USER=
DB2_PASS=
DB2_DATA=
DB2_HOST=

4. Edit the following value in the activemq.xml file:
activemq.xml: <value>jdbc:db2//DB_HOST:DB_PORT/DB_DATA</value>

5. Run the setupfiles script.

6. Run the deployer script.

7. Start Sterling B2B Integrator.

Configure the Oracle Database

Oracle database configuration checklist
Before you install Sterling B2B Integrator with the Oracle database, you must
configure the database.

Before you begin

* If you are reinstalling the software, be aware that data in your existing database
is deleted. To prevent this deletion, either back up the existing database or save
it under a different name.

* After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Oracle for Sterling B2B Integrator:

Oracle Database Configuration
Item Checklist Your Notes®

1 Create the database.

Refer to the Oracle documentation
on creating the database, including
creating a schema repository, login,
and table space.

Be sure to install the correct version
and patches.

See the System Requirements for the
supported version information.

Configure an Oracle Instance.

Configure Oracle Rollback.

Install the Oracle JDBC Driver.

G| = | WD

Enable Failover in a Multiple Node
Oracle RAC Database Cluster.
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Oracle Database Configuration
Item Checklist Your Notes®

6 After Sterling B2B Integrator is
installed, if you want to encrypt the
data traffic, perform one of the
following tasks:

* Configure Sterling B2B Integrator
for Data Traffic Encryption

» Configure Sterling B2B Integrator
for Data Traffic Encryption with
SSL

Configuring an Oracle instance
An Oracle database requires certain parameter settings and other configurations.

Before you begin

* You must have the Oracle database installed. Ensure that you have installed the
correct versions and patches. See System Requirements for supported version
information.

* Ensure that the user responsible for creating and modifying the Oracle database
has a specified quota (extent) assigned in the table space, even if the user was
assigned an unlimited table space. Otherwise, the installer might display the
error ORA-09150: no privileges on tablespace name.

Procedure
1. Run the create instance procedure. Use AL32UTF8 as the character set.

2. Configure the INIT<INSTANCE_NAME>.ORA file with the settings in the
Performance Management guide.

After you install Sterling B2B Integrator with Oracle, you can improve the
performance of the database with the settings listed in the Performance
Management guide.

3. Identify or create a table space for user tables and indexes.

4. Create a user. Unless stated for a task, the user does not require database
administrator (DBA) privileges.

5. Grant permissions to the user. The following permissions are required for the
administrative user for creating and modifying the Oracle database:

* GRANT "CONNECT" TO SI_USER

e ALTER USER SI_USER DEFAULT ROLE "CONNECT"

* GRANT CREATE SEQUENCE TO SI_USER

* GRANT CREATE TABLE TO SI_USER

* GRANT CREATE TRIGGER TO SI_USER

* GRANT SELECT ON CTXSYS.CTX_USER_INDEXES TO SI_USER
* GRANT SELECT ON SYS.DBA_DATA FILES TO SI USER
* GRANT SELECT ON SYS.DBA_FREE_SPACE TO SI_USER
* GRANT SELECT ON SYS.DBA_USERS TO SI_USER

* GRANT SELECT ON SYS.V_$PARAMETER TO SI USER

* GRANT SELECT ANY DICTIONARY TO SI_USER

* GRANT ALTER SESSION TO SI_USER

* GRANT CREATE SESSION TO SI_USER

Windows Cluster Environment Installation (V5.2.3 - 5.2.5)
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6. If you are using Oracle AQ, grant the AQ_ADMINISTRATOR_ROLE
permission.

7. If you are installing or upgrading to Sterling B2B Integrator version 5.2.4 and
plan to use EBICS Client, grant the GRANT CREATE VIEW TO SI_USER permission.

Mandatory Oracle init parameters:

The Oracle init parameters have mandatory settings for Sterling B2B Integrator
performance with an Oracle database.

Parameter Mandatory value
cursor_sharing Exact
Character set AL32UTF8

Configuring Oracle rollback
The configuration of rollback in an Oracle database helps you manage database
transactions.

About this task

You can roll back changes in Oracle by using AUTO UNDO management. IBM
recommends that you use this option. This practice avoids any manual monitoring
of UNDO segments.

If a server is upgraded from Oracle 8i, set the UNDO_MANAGEMENT=AUTO parameter in
the init<SID>.ora file. Your database administrator needs to determine the
UNDO_RETENTION setting. Ensure that the file system, which has the UNDOTBS1
tablespace, has enough space to use the AUTOGROW setting.

Installation of the Oracle JDBC driver

Sterling B2B Integrator requires the appropriate JDBC driver for the Oracle
database.

The JDBC drivers are thin client-based pure Java JDBC drivers. See System
Requirements for supported version information. The supported versions of the
JDBC driver build the correct Sterling B2B Integrator directory structure.

Enable Failover in a Multiple Node Oracle RAC Database Cluster
About this task

You can enable failover in a multiple node Oracle RAC database cluster in
Windows using traditional RAC or RAC with SCAN.

Procedure
1. Navigate to \install_dir\install\properties using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.
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2. In the sandbox.cfg file, add a new property for ORACLE_JDBC_URL, which
contains the Oracle RAC connection URL.
Choose one of the following depending on whether you are using traditional
RAC or RAC with SCAN. The property value must be one string of text
starting with ORACLE_JDBC_URL=. Your database administrator (DBA) can
modify this URL as needed:
* To configure traditional RAC, use this format:

jdbc:oracle:thin:@
(DESCRIPTION=
(ADDRESS_LIST=
(FAILOVER=0N)
(LOAD_BALANCE=0FF)
(ADDRESS=(PROTOCOL=TCP) (HOST=myhost1) (PORT=1521))
(ADDRESS=(PROTOCOL=TCP) (HOST=myhost2) (PORT=1521))

)
(CONNECT_DATA = (SERVER = DEDICATED) (SERVICE_NAME=myservicename OR mySID))

)

Note: This method uses the default Oracle RAC service provided by Oracle.
* To configure RAC with SCAN, use this format:

jdbc:oracle:thin:@host:port/service

For example:

jdbc:oracle:thin:@RAC-SCAN:1521/0RCL

Where:

RAC-SCAN is resolved to an IP address by DNS

1521 = Port number

ORCL = the name of your Oracle RAC service

Important: In order to use RAC with SCAN, you must also define a new
Oracle RAC service (you cannot use the default service) that defines one
node as the preferred node and at least one node as a failover node.

3. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). * Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

4. Enter setupfiles.cmd.

Data traffic encryption in the Oracle 11g database

You can encrypt transactions between Sterling B2B Integrator and the Oracle 11g
database. Encryption prevents anyone who is outside the system from viewing the
data that flows between Sterling B2B Integrator and the database.

The following list describes important aspects of enabling database encryption:

* At installation, encryption is turned off by default. If you want your database
transactions to be encrypted, you must enable encryption.

* The encryption can be enabled at any time.
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* Encryption applies to all database transactions between Sterling B2B Integrator
and the database.

System performance might be impacted when encryption is enabled. The extent of
this impact depends on your hardware, database configuration, transaction
volume, and the relative amount of processing time that is spent by the system
against other activities.

For more information on data traffic configuration, see [SSL With Oracle JDBC Thin|

Before you encrypt data traffic for the Oracle 11g database
The decision to encrypt data traffic for the Oracle 11g database includes different
considerations.

Consider the following items when you configure database traffic encryption:

* Sterling B2B Integrator must be installed in TCP (clear) mode before you can
configure encryption.

* Perform these changes to your database before you install Sterling B2B
Integrator.

» Configure wallets for encryption-only mode even if the wallet that is used is
empty. Enable auto login for all wallets.

* If you want to use SSL for encryption only, it is recommended to follow the
instructions in the "CASE #1: USE SSL FOR ENCRYPTION ONLY" section of the
Oracle documentation. It is not necessary to configure certificates for the wallet.
In this mode, Diffie-Hellman ciphers are used. The server and the client are not
authenticated through SSL. You must authenticate by using a user name and a
password. However, if you are running Sterling B2B Integrator on an operating
system that requires an IBM JDK, you cannot use this mode, as IBM JSSE
TrustManager does not permit anonymous ciphers. You must configure wallets
with certificates.

* If you want to use SSL for encryption and for server authentication, it is
recommended to follow the instructions in the "CASE #2: USE SSL FOR
ENCRYPTION AND SERVER AUTHENTICATION" section of the Oracle
documentation.

* If you want to use SSL for encryption and for server authentication of both tiers,
it is recommended to follow the instructions in the Oracle "CASE #3: USE SSL
FOR ENCRYPTION AND AUTHENTICATION OF BOTH TIERS" section of the
Oracle documentation, depending on how you intend to configure client or
server authentication.

* After you configure your database for data traffic encryption, the database
accepts both TCP (clear) and TCPS (encrypted) connections.

* There is a known issue in the Oracle 11g database when the listener is
configured only for TCPS. The 1snrctl utility that is used to start and stop
database listeners attempts to contact the listener, which is enabled first. You
should define the address list of the listener to contact either TCP or IPC before
it contacts TCPS.

Configure Sterling B2B Integrator for Data Traffic Encryption in
Oracle (Windows)
About this task

Use this procedure if you want to enable encryption only, with anonymous
authentication, and not SSL authentication.
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If you want to use SSL for encryption only, it is recommended to follow the
instructions in the Oracle CASE #1: USE SSL FOR ENCRYPTION ONLY section of
the Oracle documentation. It is not necessary to configure certificates for the
wallet. In this mode, Diffie-Hellman ciphers are used and neither the server nor
the client is authenticated through SSL. You must authenticate by using a
username and a password. However, if you are running Sterling B2B Integrator on
a platform that requires an IBM JDK, you cannot use this mode, as IBM JSSE
TrustManager does not permit anonymous ciphers. You must configure wallets
with certificates.

This procedure is applicable only if you are running Sterling B2B Integrator on a
platform that requires Sun JDK. The IBM JSSE TrustManager does not permit
anonymous ciphers.

If your Sterling B2B Integrator is a cluster installation, you will need to perform
this procedure on each node, starting with node 1.

Procedure
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.

3. Navigate to \install_dir\install\properties using one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

4. Open the customer_overrides.properties file and add the following
additional database connection information:

jdbcService.oraclePool.prop_oracle.net.ss1_cipher_suites=
(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
jdbcService.oraclePool.prop_oracle.net.ssl_server_dn_match=false

If you have a container configured, ensure that the same database information
is added to the customer_overrides.properties.in file. To locate the file,
navigate to \install_dir\install\properties\nodexACy. Where x gives the
node number and y gives the container number. Perform this step for all the
containers configured in the system.

5. Repeat Step 4 for the following Oracle connection pools by changing only the
poolname:

* oraclePool_local

* oraclePool_NoTrans

* oracleArchivePool

* oracleUIPool

If you have any other database pools, you will need to add the properties for
those pools.

6. Open the sandbox.cfg file and change the database connection information as
shown:
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8.

ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>) (PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

Make sure you enter the HOST, PORT, and SERVICE_NAME.

Open the activemqconfig.xml.in file and modify the database connection
information:

* Remove or comment out the following default ActiveMQ database
configuration information:

<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"
destroy-method="close" singleton="true" lazy-init="default"
autowire="default"
dependency-check="default" SCIOverrideName="persistence-bean">

<property name="driverClassName">

<value>oracle.jdbc.driver.OracleDriver</value>

</property>

<property name="url">

#:ifdef ORACLE_JDBC_URL

<value>&0RACLE_JDBC_URL;</value>

#:else

<value>jdbc:oracle:thin:@&0RA_HOST; :&0RA_PORT; :&0RA_DATA;</value>

#:endif

</property>

<property name="username">

<value>&0RA_USER;</value>

</property>

<property name="password">

<value>&0RA_PASS;</value>

</property>

<property name="maxActive">

<value>32</value>

</property>

</bean>

* Add the following ActiveMQ database configuration information:

<bean id="gis-ds"

class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"
singleton="true" lazy-init="default"

autowire="default"

dependency-check="default">

<property name="URL"><value>&0RACLE_JDBC_URL;</value></property>
<property name="user"><value>&0RA_USER;</value></property>
<property name="password"><value>&0RA_PASS;</value></property>
<property name="connectionProperties"><value> oracle.net.ss1_cipher_suites:
(SSL_DH_anon_WITH_3DES_EDE_CBC_SHA, SSL_DH_anon_WITH_DES_CBC_SHA)
oracle.net.ss1_client_authentication: false
oracle.net.ss1_version: 3.0
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive: 32

</value>

</property>

</bean>

Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.
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9. Enter StartWindowsService.cmd.

10. Restart Sterling B2B Integrator. All the database connections from Sterling B2B
Integrator are now connected through TCPS (encrypted) mode.

Configure Sterling B2B Integrator for Data Traffic Encryption in
Oracle with SSL Authentication (Windows)
About this task

Use this procedure to enable encryption and SSL authentication. This procedure is
applicable if you are running Sterling B2B Integrator on a platform that requires
either Sun JDK or IBM JDK.

The example in this procedure uses 2-way SSL authentication. If you want to use
SSL for encryption and for server authentication, it is recommended to follow the
instructions in the Oracle CASE #2: USE SSL FOR ENCRYPTION AND SERVER
AUTHENTICATION section of the Oracle documentation.

You can also configure 1-way SSL authentication. If you want to use SSL for
encryption and for server authentication of both tiers, it is recommended to follow
the instructions in the Oracle CASE #3: USE SSL FOR ENCRYPTION AND
AUTHENTICATION OF BOTH TIERS section of the Oracle documentation,
depending on how you intend to configure client and/or server authentication. For
more information about 1-way SSL authentication, refer to Oracle documentation,
which can be accessed from |http:/ /www.oracle.com /technology /tech /java/|
[sqlj_jdbc/pdf/wp-oracle-jdbc_thin_ssl.pdf]

If your Sterling B2B Integrator is a cluster installation, you will need to perform
this procedure on each node, starting with node 1.

Procedure
1. Install Sterling B2B Integrator in TCP (clear) mode.
2. Stop Sterling B2B Integrator.

3. Navigate to \install_dir\install\properties using one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). + Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

4. Open the customer_overrides.properties file and add additional database
connection information:

jdbcService.oraclePool.prop_javax.net.ssl.trustStore=/.../path/.../
ClientKeyStore. jks
jdbcService.oraclePool.prop_javax.net.ssl.trustStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.trustStorePassword=
password

jdbcService.oraclePool.prop_oracle.net.ssl_version=3.0
jdbcService.oraclePool.prop_javax.net.ssl.keyStore=/.../path/.../
ClientKeyStore.jks
jdbcService.oraclePool.prop_javax.net.ss1.keyStoreType=JKS
jdbcService.oraclePool.prop_javax.net.ssl.keyStorePassword=password
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5. Repeat step 4 for the following Oracle connection pools by changing only the
poolname:

» oraclePool_local
» oraclePool_NoTrans
» oracleArchivePool
» oracleUIPool
If you have any other database pools, you will need to add the properties for
those pools.
6. Open the sandbox.cfg file and change the database connection information to:

ORACLE_JDBC_URL= jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=tcps)
(HOST=<DB host>) (PORT=<TCPS port as configured in DB config section above>))
(CONNECT_DATA=(SERVICE_NAME=<service name>)))

7. Navigate to \install_dir\install\activemq\conf using one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

8. Open the activemqconfig.xml.in file and modify the database connection
information:

* Remove or comment out the following default ActiveMQ database
configuration information:

#:1fdef ORACLE

<bean id="gis-ds" class="org.apache.commons.dbcp.BasicDataSource"
destroy-method="close" singleton="true" lazy-init="default"
autowire="default"
dependency-check="default" SCIOverrideName="persistence-bean">

<property name="driverClassName">

<value>oracle.jdbc.driver.OracleDriver</value>

</property>

<property name="url">

#:ifdef ORACLE_JDBC_URL

<value>&0RACLE_JDBC_URL;</value>

#:else

<value>jdbc:oracle:thin:@&0RA_HOST; :&0RA_PORT; : &0RA_DATA;</value>

#:endif

</property>

<property name="username">

<value>&0RA_USER;</value>

</property>

<property name="password"><value>&0RA_PASS;</value>

</property>

<property name="maxActive"><value>32</value>

</property>

</bean>

#:endif

* Add the following ActiveMQ database configuration information:

<bean id="gis-ds"

class="oracle.jdbc.pool.OracleDataSource" destroy-method="close"

singleton="true" lazy-init="default" autowire="default"

dependency-check="default">

<property name="URL"><value>&0RACLE_JDBC_URL;</value></property>
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<property name="user"><value>&0RA_USER;</value></property>
<property name="password"><value>&0RA_PASS;</value></property>
<property name="connectionProperties"><value>
javax.net.ssl.trustStore: /.../path/.../ClientKeyStore.jks
javax.net.ssl.trustStoreType:JKS
javax.net.ssl.trustStorePassword:password
oracle.net.ss1_version:3.0

javax.net.ss1.keyStore: /.../path/.../ClientKeyStore.jks
javax.net.ss1.keyStoreType:JKS
javax.net.ss1.keyStorePassword: password
driverClassName:oracle.jdbc.driver.OracleDriver
maxActive:32

</value>

</property>

</bean>

9. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). * Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

10. Enter StartWindowsService.cmd.

11. Restart Sterling B2B Integrator. All the database connections from Sterling B2B
Integrator are now connected through TCPS (encrypted) mode.

Configure the Microsoft SQL Server Database

Microsoft SQL Server database configuration checklist
Before you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must configure the database.

Before you begin

* If you are reinstalling the software, be aware that data in your existing database
is deleted. To preserve your data, either back up the existing database or save it
under a different name.

* After you create and configure your database, recycle the database. Then, stop
and restart to apply the changes.

About this task

Use the following checklist to configure Microsoft SQL Server for Sterling B2B
Integrator:
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Microsoft SQL Server Database
Item Configuration Checklist Your Notes

1 If you do not have Microsoft SQL
Server installed, follow the installation
procedures in the SQL Server
installation manual.

Refer to the Microsoft SQL Server
documentation on creating the
database, including creating a schema
repository, login, and table space.

Be sure to install the correct version
and patches.

See System Requirements for supported
version information.

2 (SQL Server 2005 only) |"Installing tha
Microsoft SQL Server 2005 service pack|

and hot fix” on page 19|

3 “Microsoft SQL Server database|

Earameters”|

4 “Microsoft SQL Server database user|

Erivileges”|

5 “Configuring the snapshot feature for]|
Microsoft SQL Server” on page 20|

Microsoft SQL Server database user privileges

In Microsoft SQL Server, you must grant DBO (Database Owner) permission to the
user. The DB_DDLADMIN role is required for creating objects in the SQL Server
database.

Microsoft SQL Server database parameters

When you install Sterling B2B Integrator with the Microsoft SQL Server database,
you must set certain Microsoft SQL Server parameters. Other Microsoft SQL Server
parameter settings are recommended for the efficient performance of Sterling B2B
Integrator.

When you install Sterling B2B Integrator with Microsoft SQL Server, you must set
the Microsoft SQL Server parameters that are listed in [‘Mandatory settings for|
[Microsoft SQL Server.”|

After you install Sterling B2B Integrator with Microsoft SQL Server, you can
improve the database performance by setting the recommended parameters that
are listed in the performance documentation for the following items:

* Instance-specific settings for Microsoft SQL Server
* Database-specific settings for Microsoft SQL Server

Mandatory settings for Microsoft SQL Server:

The default collation of Microsoft SQL Server must match the collation for the
Sterling B2B Integrator database to prevent collation conversions.
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The tempdb database that is used by Microsoft SQL Server must be created with the
same collation as the default collation of Microsoft SQL Server. The Microsoft SQL
Server uses the tempdb database for results that are too large to fit in memory.

If the collations of the tempdb database and the Sterling B2B Integrator database
differ, the database engine must convert from the Sterling B2B Integrator collation
to the tempdb collation, and then back again before it sends the results to the
Sterling B2B Integrator server. These conversions might lead to severe performance
issues.

The collation that is required for the Sterling B2B Integrator database is a collation
that most closely matches the character set used by Java. By using this collation,
you can avoid character data conversions before the data is stored in the database
tables. Use the mandatory parameter that is described in the following table when
you configure the collation setting;:

Parameter Value

Database Collation SQL_Latin1l_General_CPP850_Bin

Additionally, you must perform these tasks:
* Allow Microsoft SQL Server to manage memory dynamically (default).

* Disable any antivirus software that is running on the Microsoft SQL Server
data, transaction log, and binary files directory.

Installing the Microsoft SQL Server 2005 service pack and hot fix
You can update a SQL Server 2005 database with service packs and hot fixes.

Before you begin

* Ensure that Named Pipes and TCP/IP protocols are enabled in the network
utility of the SQL Server database.

* Do not use case-sensitive column names in the database. Case-sensitive names
prevent the SQL Server 2005 System Management Console from loading.

Procedure

To install Microsoft SQL Server 2005, Service Pack 2 and hot fixes:
1. Install the Microsoft SQL Server 2005 base release.

2. Install the Microsoft SQL Server 2005 Service Pack 2. You can download it from
Ihttp: / /www.microsoft.com/en-us/download/ detaﬂs.aspx?id:9969l

3. Apply the cumulative hot fix package. You can download it from
[http:/ /support.microsoft.com /default.aspx?scid=kb;EN-US;933097}

4. Apply the GDR2 hot fix. You can download it from
lsupport.microsoft.com /kb /934459 /|

Install the JDBC Driver in Microsoft SQL Server 2005
About this task

Sterling B2B Integrator requires the correct Microsoft SQL Server driver. See System
Requirements for supported version information.

Go to the Microsoft web site to download the driver and any appropriate patches.
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Procedure
1. Download sqljdbc_version_language.tar.gz to a temporary directory.
2. To unpack the zipped tar file, navigate to the directory where you want the

driver unpacked and type the following command: gzip -d
sqljdbc_version_language.tar.gz

3. To unpack the tar file, move to the directory where you want the driver
installed and type the following command: tar —xf
sqljdbc_version language.tar

After the package unpacks, you can find out more information about using this
driver by opening the JDBC Help System in the \absolutePath\sqljdbc_version\
language\help\default.htm file. This will display the help system in your Web
browser.

4. When the Sterling B2B Integrator installation asks for the location of the JDBC
drivers, specify the extracted jar file created after unpacking the archive
(usually named sqljdbc.jar). The JDBC driver version is the same as the version
of the drivers downloaded from Microsoft.

Configuring the snapshot feature for Microsoft SQL Server

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks.

Procedure

Enter the following command to enable the snap shot feature:
ALTER DATABASE db_name SET READ_COMMITTED_SNAPSHOT ON;

Database Password Management

Database passwords
A password is used by the system to connect to its database. The password is
stored as clear text in a system property file.

If the security policies at your company require you to encrypt these passwords,
you can do so after you install the system. Encrypting these passwords is optional.

Database passwords encryption methods
Database passwords are encrypted with one of two methods: 0BSCURED or
ENCRYPTED.

The encryption method is decided by the value of the encryptionPrefix property
in the propertyEncryption.properties or the
propertyEncryption.properties_platform_security ext file.

Encrypt Database Passwords (Windows)
About this task

To encrypt the database password:

Procedure
1. Stop Sterling B2B Integrator.
2. Navigate to \install_dir\install\bin using one of the following methods:
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For Windows Server 2003 or earlier

For Windows Server 2008 or later

Open a command prompt window (from the
Run dialog box).

Complete the following steps:
* Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

Enter enccfgs.cmd.
Enter setupfiles.cmd.
Enter deployer.cmd.

ook~ w

7. Enter your passphrase.

Enter startWindowsService.cmd to start Sterling B2B Integrator.

Decrypt Database Passwords (Windows)

About this task
To decrypt the database password:

Procedure
1. Stop Sterling B2B Integrator.

2. Navigate to \install_dir\install\properties using one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008 or later

Open a command prompt window (from the
Run dialog box).

Complete the following steps:
* Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

3. Open the sandbox.cfg file.

Copy encrypted password from the database_PASS property.

Use the text that appears after the database_PASS= text. For example, if
database_PASS= OBSCURED:123ABCxyz321, you would copy the text
OBSCURED:123ABCxyz321. (OBSCURED is the encryption method for the

password.)

5. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008 or later

Open a command prompt window (from the
Run dialog box).

Complete the following steps:
* Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

6. Enter decrypt string.cmd encrypted password.

For encrypted_password, use the text that you copied in Step 4.

You are prompted for the system passphrase.

Your decrypted password appears.
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7. Navigate to \install_dir\install\properties using one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008 or later

Open a command prompt window (from the
Run dialog box).

Complete the following steps:

Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

8. Edit the sandbox.cfg file to replace the encrypted password with the password

that was returned in Step 6.

9. You need to decrypt the entries for YANTRA_DB_PASS and DB_PASS. Repeat
Steps 4 to 8 to decrypt these entries. You should also decrypt any passwords
present in the property files. Encrypted passwords typically reside in the

following property files:

* sandbox.cfg

* apservsetup

* jdbc.properties/.in

* customer_overrides.properties/.in

10. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008 or later

Open a command prompt window (from the
Run dialog box).

Complete the following steps:

Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

11. Enter setupfiles.cmd.
12. Enter deployer.cmd.

13. Enter startWindowsService.cmd to start Sterling B2B Integrator.

Installation Checklist

Installation Checklist for a Windows Cluster Environment

The installation checklist contains the items you need to gather and tasks you need
to complete prior to installing the Sterling B2B Integrator. The checklist contains:

* Brief descriptions for tasks (detailed procedures are provided after the checklist)

* Information you need to gather to complete the installation

You may want to make a copy of the following checklist and use it to record the
information you collect for each node in the cluster.

The cluster environment does not support the following items:

* MySQL database
* AS2 Edition
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Installation Checklist for a
Windows Cluster

Node 1

Node 2

Your Notes

Review your IBM contract to
determine what software you
have licensed. You need to
know this License Information
so that you can select the
correct components/features
to install.

Determine which installation
method you are going to use:

* IBM Installation Manager
* Silent Installation

Decide which type of security
certificates you will use:

* The default self-signed SSL
(Secure Sockets Layer)
certificate that is
automatically installed.

* A Certificate
Authority-related certificate
that you install before
installing the software.

If you are using an Oracle,
Microsoft SQL Server, or DB2
database, decide if you are
going to manually or
automatically apply Database
Definition Language (DDL)
Statements (schema) to the
database.

If you are using an Oracle
11.1 database, you must set it
up for native compilation by
allocating space and by
setting the
plsql_native_library_dir
parameter.

Determine if the database
password needs to be
encrypted.

Record the Hostname on
which you plan to install the
software.

Record the Directory Name
where you plan to install the
software.

Record the Login to host
machine.

10

Record the Password to the
host machine.

11

Record the path to the
installation wizard and file
name.
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Installation Checklist for a
Windows Cluster

Node 1

Node 2

Your Notes

12

Record the path to JDK.

13

Record the path to JCE file.

14

Record the Host IP address.

15

Record the Initial Port
Number.

16

Record the System passphase.

17

Record the Database vendor
name.

18

Record the Database user
name.

19

Record the Database
password.

20

Record the Database (catalog)
name.

21

Record the Database host
name.

22

Record the Path and file
name for the JDBC Driver(s).

23

Determine if your Windows
environment is:

* Windows 2003 or earlier
* Windows Server 2008

24

Ensure you have read and
write privileges on the parent
installation directory.

License information

IBM provides the license files for each feature of Sterling B2B Integrator that you

purchased with the software media. You do not have to contact IBM Customer
Support to get the license files.

A separate license is required for each Sterling B2B Integrator feature that you

purchased. During installation, you must choose the license files according to what
you purchased. IBM Customer Support audits the system as soon as your system

is in use.

After the installation finishes, if you determine that you need to modify licenses
files, see [“License modifications” on page 75

Extracting the core license file

The Core_License.xml file is required during the installation or upgrade of Sterling

B2B Integrator.

About this task

To extract the Core_License.xm] file:
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Procedure

1. Download the SI_5020400. jar file from Passport Advantage® to a temporary
location.

2. From a command line, open the directory where the SI_5020400. jar file is
located.

3. Type the following command to extract the contents of the JAR file: jar -xvf
SI_5020400.jar

4. Type the following command to change directories to the middleware folder: cd
./middleware

5. From the middleware directory, extract the Core_License.xml file by typing the
following command: jar -xvf h_B2BF_4020400.jar

6. The Core_License.xml file is in the newly extracted directory:
B2BF/components/b2b_base/files/properties/licensefiles

7. Copy the Core_License.xml file to a temporary location where you can point to
it during your installation or upgrade.

Multicast ports in node to node communications

Cluster nodes are configured to communicate with each other using JGroups, an
open source toolkit that provides flexibility for protocol configuration.

JGroups provides rich open management features, along with multiple protocol
support. JGroups supports multicast (UDP) and TCP-based communication
protocols.

When JGroups is configured to use multicast (UDP), all cluster nodes communicate
with each other on a specific IP address and port. The configuration of multicast
ports is based on the installation base port. All clusters that are on the same subnet
that is configured on the same base port send multicasting messages on the same
multicast IP address and port.

To avoid this situation, each cluster on the same subnet needs to be configured on
different base ports. Install your clusters on different port ranges or on different
network segments with multicast forwarding restricted, so that they do not
interfere with each other. The default multicast address is 239.255.166.17. This
address is configurable, with a port range of 10 ports, starting with the multicast
base port for the instance.

All nodes that are participating in the same cluster must be installed on the same
multicast base port (the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext.in file). This value is usually
computed from the system base (non-multicast) port, but can be configured
separately in the noapp.properties_platform_ifcresources_ext.in file, to allow
different nodes in a cluster to be installed at different (non-multicast) port ranges.
Also, all the nodes in the cluster must be installed in the same subnet.

For node to node communications, the properties are defined in the
Jjgroups_cluster.properties file. The following attributes are used to define
communications:

* property_string - default value is UDP.

* distribution_property_string - default value is TCP. This attribute must never
be set to UDP.
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If you want to change the communication for cluster multicast from the UDP
protocol to TCP, you need to change the value of the property_string property in
the jgroups_cluster.properties.in file (after you back up the file). Then, run the
setupfiles command. You can change this value right after the installation or after
you start running the cluster. If you change the file after you start the cluster, you
need to stop all nodes of the cluster, change the value on each node, and then
restart your cluster.

To change the communication for cluster multicast from the UDP protocol to TCP,
use the following value for the property_string property in the
Jgroups_cluster.properties.in file:

property string=TCP(start_port=any available_port number):

TCPPING (initial_hosts=this_instance_host_ip[start_port_number],
theothernode_instance_host_ip[theothernode_start_port_number];port_range=2;
timeout=5000;num_initial_members=3;up_thread=true;down_thread=true):
VERIFY_SUSPECT(timeout=1500) :pbcast.NAKACK(down_thread=true;up_thread=true;
gc_lag=100;retransmit_timeout=3000) :pbcast.GMS(join_timeout=5000;
join_retry_ timeout=2000;shun=false;print_local_addr=true;
down_thread=true;up_thread=true)

For more information about UDP, TCP, and JGroups communications, see the
Sterling B2B Integrator Clustering documentation.

Port Numbers in a Windows Environment

During installation or an upgrade, you are prompted to specify the initial port
number for Sterling B2B Integrator.

To specify an initial port number, follow these guidelines:

 Sterling B2B Integrator requires a range of 200 consecutive open ports between
1025 and 65535. The port range starts with the initial port number and ends
with the number that equals the initial port number plus 200. For example, if
you specify 10100, then you need to make sure that 10100 through 10199 are not
used by any other applications on your system.

Note: Because of RMI, on occasion, a port number outside the range may be
assigned.

* The initial port number represents the beginning port number in the range.

* Make sure that port numbers in the port range are not used by any other
applications on your system.

During the upgrade, about 50 default ports are pre-assigned for different services.
For example, if you do not want xxx32 (10132) to be a default port, you could
assign that port to xxx97 or another number within the port range.

After your installation or upgrade, refer to the \install_dir\install\ properties\
sandbox.cfg file for all of the port assignments.

Security certificates

You can choose between different security certificates before you install Sterling
B2B Integrator.

Before you begin the installation, you must decide which of the following security
certificates to use:

* The default self-signed SSL (Secure Sockets Layer) certificate that is
automatically generated by the installation.
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* A Certificate Authority-related certificate that you generate before you install the
software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can change the certificate with the ss1Cert property in
the noapp.properties_platform_ifcresources ext.in file.

Install the Software

General Installation/Upgrade Information for a Windows
Cluster Environment

CAUTION:

Sterling B2B Integrator should be installed behind a company firewall for
security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integrator documentation library for more information on secure

deployment options.

The cluster environment does not support the following items:

* MySQL database
» AS2 Edition

Installation Scenarios for Version 5.2.3

It is important to review the following installation scenarios:

Scenario

Instructions

Version 4.x is installed as the base release
and it needs to be upgraded to the 5.2.3
level.

Use the Upgrade the Software instructions
provided in the Windows Non-Cluster
Environment Upgrade guide for version 5.2.3.

Version 5.0 is installed as the base release
and it needs to be upgraded to the 5.2.3
level.

Use the Upgrade the Software instructions
provided in the Windows Non-Cluster
Environment Upgrade guide for version 5.2.3.

Version 5.1 is installed as the base release
and it needs to be upgraded to the 5.2.3
level.

Use the Upgrade the Software instructions
provided in the Windows Non-Cluster
Environment Upgrade guide for version 5.2.3.

Version 5.2.0 is installed as the base release
and it needs to be upgraded to the 5.2.1
level.

Use the Install Version 5.2.1 - 5.2.3 as a Fix
Pack instructions provided in the Install the
Software chapter.

Version 5.2.1 is being installed as the base
release.

You will need to review this document and
use the installation instructions in the Install
the Software chapter.

Version 5.2.1 is installed as the base release
and it needs to be upgraded to the 5.2.2
level.

Use the Install Version 5.2.1 - 5.2.3 as a Fix
Pack instructions provided in the Install the
Software chapter.

Version 5.2.2 is being installed as the base
release.

You will need to review this document and
use the installation instructions in the Install
the Software chapter.

Version 5.2.2 is installed as the base release
and it needs to be upgraded to the 5.2.3
level.

Use the Install Version 5.2.1 - 5.2.3 as a Fix
Pack instructions provided in the Install the
Software chapter.
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Scenario Instructions

Version 5.2.3 is being installed as the base You will need to review this document and
release. use the installation instructions in the Install

the Software chapter.

Installation Methods

Use one of the following methods to install your system:

IBM Installation Manager (Graphical User Interface)
IBM Installation Manager (Text Based)

Silent Installation method

General Installation Guidelines

General installation guidelines include the following:

Do not create the installation directory manually before the start of the
installation. If you create the installation directory before you begin, the
installation will fail.

The server on which you are installing must have adequate free disk space.
The installation directory must have adequate free disk space.

The name of the directory cannot include spaces and must be less than 30
characters long excluding separators. Using a directory name of more than 30
characters could create an install that is impossible to delete. An example of an
installation directory is C:\SI_52\install_dir\install.

All nodes must use the same database.
All nodes must use the same passphrase.
All nodes must use the same operating system.

When installing nodes on different machines, the initial port numbers must be
the same. Installing nodes are different machines helps you take advantage of
cluster features such as, reliability, availability, scalability, and failover.

When installing nodes on the same machine, you must install node 2 and higher
in different directories. Each initial port must be at least 200 higher or lower
than the initial port for the other nodes.

If you need to install more than one instance of Sterling B2B Integrator on the
same Windows server, you must install the second instance in a different
directory.

If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.

Sterling B2B Integrator does not support IPv6 installation on Windows. Before
applying an IPv6 address, see the IPv6 Capabilities section in the System
Requirements.

The installation creates subsequent ports based on the initial port number. For
all of the port assignments, see the \install_dir\install\properties\sandbox.cfg
file.
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General Installation Manager information

The IBM Installation Manager Software Delivery Platform is an installation
management tool that installs and maintains Installation-Manager-based software
packages.

Use the Installation Manager to modify feature sets and search for updates of
installed software. The Installation Manager ensures that only compatible fixes are
applied to a software installation.

Important: The on-screen options Manage Licenses, Roll Back, Modify, and
Update are not functional as part of the Sterling B2B Integrator release 5.2.3.
Additionally, the Uninstall option only removes Sterling B2B Integrator from the
Installation Manager. The uninstall procedure as described in Uninstall Sterling B2B
Integrator from a Windows Non-Cluster Environment still must be performed to
completely uninstall Sterling B2B Integrator.

Attention: If you are using Installation Manager to install Sterling B2B Integrator
version 5.2.3 and you plan on using the Financial Services License, you need to
manually install the license.

The Installation Manager must be installed on each computer on which Sterling
B2B Integrator is being installed. If you have an existing version of Installation
Manager installed on your computer for use with other IBM applications, it can be
used with Sterling B2B Integrator. If you do not have the Installation Manager
installed, it is provided as part of the installation media and can be installed as
part of the Sterling B2B Integrator installation.

The Installation Manager user interface provides the following features:

* The choice of either entering the paths or selecting the paths and files (Select
File).

* Internal navigational buttons on every screen in the Installation Manager. You

need to click Next to move to the next step. The click Next step is not
represented in each step in the procedure.

Important: The Next button does not activate until you enter data on a screen.
For fields that require validation, you must click out of the field somewhere on
the screen to trigger the validation and after validation completes, the button
activates.

* For every screen in the text-based installation wizard, you need to press Enter to
move to the next step. The press Enter step is not represented in each step in the
procedure.

* Numbered options for each step in the Installation Manager’s text mode, you
need to press Enter to move to the next step.

* The ability to navigate to the different installation configuration pages out of
sequence. The following icons indicate the status of a configuration page:

|

- page is completed

Rad

- current page you are on
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|;__|

- required entry

X
- page not completed

Note: All the pages must have a

&

to continue.
Additional heap memory parameters

The heap memory parameters specify the amount of memory the Installation
Manager can use during the installation process. The heap memory pool sizes that
are used by the Installation Manager are hardcoded defaults. If these defaults are
not sufficient for your environment, you can specify different values by adding
parameters to the Installation Manager’s config.ini file.

Important: These additional parameters are needed only if you are experiencing
Out Of Memory errors during the installation process.

The following parameters can be added:
* memoryMin=user.sb.INSTALL_<0S>_INIT_HEAP.<amount_of memory>
* memoryMax=user.sb.INSTALL <0S> MAX HEAP.<amount_of memory>

Where <0S> is the user’s operating system and <amount_of_memory> is the specified
amount of memory.

Operating
System

Parameter

Example Entry

Sun-Solaris

Initial Heap Size

INSTALL_SUN_INIT_HEAP

memoryMin=user.

sb.

INSTALL_SUN_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_SUN_MAX_HEAP

memoryMax=user.

sb.

INSTALL_SUN_MAX_HEAP.3072m

INSTALL_AIX_INIT_HEAP

Linux Initial Heap Size memoryMin=user.sb.INSTALL_LINUX_INIT_HEAP.3072m
INSTALL_LINUX_INIT_HEAP
Maximum Heap Size memoryMax=user.sb.INSTALL_LINUX_MAX_HEAP.3072m
INSTALL_LINUX_MAX_HEAP

AIX® Initial Heap Size memoryMin=user.sb.INSTALL_AIX_INIT_HEAP.3072m

Maximum Heap Size

INSTALL_AIX_MAX_HEAP

memoryMax=user.

sbh.

INSTALL_AIX_MAX HEAP.3072m
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Operating

System Parameter Example Entry

HP-UX Initial Heap Size memoryMin=user.sb.INSTALL_HPUX_INIT_HEAP.3072m
INSTALL_HPUX_INIT_HEAP
Maximum Heap Size memoryMax=user.sb.INSTALL_HPUX_MAX_HEAP.3072m
INSTALL_HPUX_MAX_HEAP

Windows |Initial Heap Size memoryMin=user.sb.INSTALL WIN_ INIT HEAP.3072m

INSTALL_WIN_INIT_HEAP

Maximum Heap Size memoryMax=user.sb.INSTALL_WIN_MAX_HEAP.3072m

INSTALL_WIN_MAX_HEAP

Installing in a Windows cluster environment with the IBM
Installation Manager in GUI mode

You can install Sterling B2B Integrator in a Windows cluster environment with the
IBM Installation Manager in a graphical user interface (GUI) mode.

Before you begin

Complete the [“Installation Checklist for a Windows Cluster Environment” on|

IEage 22.|

Access the JAR file for your installation. The JAR file depends on your operating
system and current version of Sterling B2B Integrator. Refer to the following
websites for the correct JAR file. Consult with your IBM representative to
identify the correct JAR file for your installation.

— Refer to |[Fix Central| to see if you must use an interim fix or fix pack JAR file

for the installation.

— Refer to [Passport Advantage] to see if you must use an installation JAR file for
the installation.

If you are use the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must install SPE before you install Sterling B2B Integrator.

If you are using the EBICS Banking Server application with Sterling B2B
Integrator 5.2.5, the data encryption for storage within the installation location is
not supported.

Procedure

1. Close all open Windows programs and any command prompt windows.

2. From the installation media, copy the compressed installation package to a
location on your desktop.

3. Decompress the installation package.

4. Open the IMSI (Installation Manager) folder that is in the directory structure
that is created when the installation package was decompressed. The directory
includes several IM_OperatingSystem.zip files.

5. Decompress the IM_Win.zip file. This action creates a new IM_Win folder.
6. Open the new IM_Win folder.
7. Start the installation:

a. Right-click the userinst.exe file.

b. Click Run as administrator.
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8. On the Install Packages page of the Installation Manager, click Next.

9. Review the license agreement and select the option I accept the terms in the
license agreement.

If you do not accept the agreement, the installation process does not continue.

10. Select the location for the shared resources directory and click Next. This
directory is used by the Installation Manager for the Sterling B2B Integrator
installation and other installations.

The shared resources directory cannot be a subdirectory of the directory for
the installation of Sterling B2B Integrator. The shared resources directory must
be empty.

11. Select the directory for the installation of Sterling B2B Integrator and click
Next.

Important: For node 2 and higher, you must specify a different installation
directory.

The installation directory must be empty. During the installation, the installer
creates a directory that is named install that contains the installation files.

The system confirms that you have enough space on your system to complete
the installation.

If you have other products installed that use the Installation Manager, updates
for those products might appear in your listing.

12. After you review the disk space information, click Next.

13. Type the path to your JDK directory and click Next.

14. Select the feature or features to install and click Next.
Select only the licenses and features that were defined by your IBM contract.
If you are unsure which to select, the installation can proceed without a
selection and complete successfully. Startup and operation of the software,

however, requires one of the licenses to be selected. See
[modifications” on page 75| to apply licenses after the installation.

Note: Sterling File Gateway requires extra installation steps. See
[Sterling File Gateway (2.2.2 and higher)]

* IBM Sterling B2B Integrator and/or IBM Sterling File Gateway

Important: Sterling File Gateway requires extra installation steps. See
[[nstalling Sterling File Gateway (2.2.2 and higher)]

* FIPS Module

— FIPS Compliance Mode (Must enable FIPS Module)
* (5.2.5 and higher) NIST 800-131a Compliance Mode

— off (default value)

— transition

— strict
* AS2 Edition Module
* Financial Services Module
* EBICS Banking Server Module

* (5.2.5 and higher) SPE Integration Module (Requires pre-install of SPE,
WTX optional)

If you select the SPE option, you are prompted for the following
information:

— SPE installation directory
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— (Optional) WebSphere® Transformation Extender (WTX) installation

directory
— SPE Ul port

For more information, see the documentation for the integration of Sterling

B2B Integrator and SPE.

15. Type the path to the JCE policy file and click Next.
16. Type the path to the installation JAR file and click Next.
17. Enter the following server location information and click Next:

a. Type the explicit IP address or host name for the server or use the default

value of Tocalhost.

b. Type the initial port number or use the default value of 8080.

Note: For node 2 and higher, you must use a different unique port

number.

18. Enter the system passphrase information and click Next:

a. Type a passphrase.
b. Confirm the passphrase.

19. Type the email information and click Next:

a. Type the email address to which you want system alert messages sent.

b. Type the SMTP mail server (IP address or host name) that you want to use
for system alert messages and other administrative notices.

20. Enter the following database information and click Next.

a. Select the database vendor that you want to use:

* Oracle

* (5.2.3 - 5.2.4.2) Microsoft SQL Server 2005
* (5.2.5 and higher) Microsoft SQL Server 2012

* DB2
* MySQL

Important: You cannot use a MySQL database in a cluster installation.

b. Select all of the following options that apply to this installation:

Choices:

Action

(Not for MySQL) This installation is for a
cluster node 2 or higher

¢ For the first node, do not select this
option.
* For node 2 and higher, select this option.

(Not for MySQL) Apply database schema
automatically?

The default is to automatically apply the
DDL (Data Definition Language) statements
that apply the database schema.

If you want to manually create the database
schema, then clear the Apply database
schema automatically check box and
continue with the remaining installation
steps.

Important: If you manually apply the
schema, the installation stops without error
later in the installation process so that you
can manually apply the schema.
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Choices:

Action

(Oracle only) What Datatype you would Select either the default BLOB (binary large
like to use? object) columns data type or the Long Raw

data type.

You can significantly improve performance
by enabling the cache on the BLOB data
object in Oracle. For more information, see
the Sterling B2B Integrator documentation
for slow performance in Oracle.

21. Type the following database connection information. Do not click Next until
you configure the JDBC driver in the next steps.

User name

Password (and confirmation)

Catalog name

Host

Port

22. Select a JDBC driver or drivers and click Next:

a. Click Add to browse to the file location for the appropriate JDBC driver or
drivers:

(Oracle and Microsoft SQL Server only) Absolute path and file name for
one JDBC driver file.

(DB2 only) Absolute paths and file names for two JDBC driver files. Use
the Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol that is used directly by DB2, allowing a direct call
from the system to the DB2 server.

Click Test to confirm that the driver is supported for the database and
Sterling B2B Integrator.

Tip: Make sure that you select the driver path in the Database driver field
before you click Test.

The Installation Manager must successfully validate the connection to the
database before you can continue with the installation. If there is a
validation failure, you can view the system log to determine more
information about the failure. Perform the following tasks:

1)

Identify the location of the user’s application directory. Click Start >
Run and enter the command %APPDATA%.

Open the user’s application directory: local_path\IBM\Installation
Manager\logs

Open theindex.xml file in a browser.
Identify the log file that is based on the time stamp of when you
started the installation.

Click the installation file to view a listing of errors that occurred
during that installation.

23. Determine which of the following options apply to this installation. Select the
applicable options and click Next:

* Verbose install?

* This installation is an upgrade from a prior version

Do

not select this option because this installation is a new installation.
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Important: For node 2 and higher, this option might be selected by default.
This default selection causes the display of the option Would you like to
run upgrade pre-check?. Clear the check box before you continue.

24. Determine what performance configurations apply to this installation and
click Next. Accept the default value or type the appropriate value.

25.

* Number of Processor Cores
* Physical Memory (MB) allocated to Sterling B2B Integrator

Review the installation package summary information. Click Install to apply
your installation settings to the installation.

If you did not select the option to automatically apply the database schema,
the installation stops and you must perform these additional steps to complete
the installation with manual DDL statements:

a.
b.
c.

Open the installation directory.
Locate the Instal1SI.Tog file and open it with a file editor.
Search the file for these error messages:

e <§I Install>/repository/scripts/EFrame_IndexAdds.sql must be
applied to the database.

e <§I Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.

» <SI Install>//repository/scripts/EFrame _TableChanges.sql must be
applied to the database. Exiting installation..."

Important: If you do not find these error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you find these messages,
continue with the remaining steps.

. Edit each .sql script for the database. These changes might include

changing the SQL delimiter or adding table space options.

. Log in to the database as the database schema user.

Run the following SQL files manually in this order:

Important: When you are running the scripts, you must run the SQL
scripts in the specified order.

* EFrame_IndexDrops.sql

» EFrame_TableChanges.sq]l

* EFrame_IndexAdds.sql

* EFrame_TextIndexAdds.sq]l

* EFrame_Sequence.sq]l

* EFrame_TextIndexModify.sql
* EFrame_TextIndexUpdates.sql
* EFrame_TextIndexUpgrade.sql
* EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names that are
based on the name of the installation node. Table generation is not
included in these SQL scripts, but is performed automatically during the
initial start of Sterling B2B Integrator or when a new cluster node is added.
Table generation might fail if security restrictions reduced the Sterling B2B
Integrator database user permissions. To avoid this issue, ensure that the
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26.

27.

28.

DBADM role permissions are enabled during the initial startup. If further
issues arise, contact IBM customer support for guidance.

g. Exit from the database.

h. Open the parent directory of the Sterling B2B Integrator installation
directory.

i. Delete (or rename as a backup) the installation directory.

j. Restart the installation wizard and provide the same installation options

that you provided before you cleared the Apply database schema
automatically check box.

The Installation Progress screen indicates which component of the installation
is in process.

A status bar below the Repository Information heading displays the progress
of the component installation. When the installation completes, a large green
circle with a check mark displays with the message The packages are
installed. A link is provided to view the installation log file.

Click Finish. The Installation Manager closes and you are returned to your
desktop.

Check the InstallSI.Tog file to verify that all of the components were
installed properly.

If you are installing on Windows 2008, see [“Configure the Sterling B2B|
[[Integrator Desktop Icon for Windows Server 2008” on page 52

To install each additional node, open the Installation Manager folder and start
a new installation. See step

For node 2 and higher, follow the same steps as you did for node 1 until you
get to the step with the This installation is for a cluster node 2 or higher
check box. Select that box.

If you installed multiple nodes on the same server or used different base ports
for node 2 onward, you need to complete the following steps:

Step | Action Your Notes

1

Open the install_dir\install\properties directory for node
1.

In the noapp.properies_platform_ifcresources_ext file,
record the value for multicastBasePort.

In thejgroup_cluster.properties file, record the values for
the mcast_port parameters of the property_string and
lock.protocolStack properties.

For each subsequent node, perform the remaining steps.

Open the \install_dir\install\properties directory for each
node (node 2 and higher).

In thenoapp.properies_platform_ifcresources_ext.in file,
update the value of the multicastBasePort property to match
the value for node 1.

For example, replace the string &MULTICAST_NODE_PORT1; with
the port number 45460:

* (before) multicastBasePort=8MULTICAST_NODE_PORT1;
* (after) multicastBasePort=45460

In the jgroups_cluster.properties.in file, update all
occurrences of mcast_port to match the values for node 1.
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Step | Action Your Notes

After you updated the attributes for all of the nodes, enter the
command \install_dir\install\bin\setupfiles.cmd for
node 2 and higher.

29. (This step applies only if you are installing Sterling B2B Integrator 5.2.5.0.)

After the Sterling B2B Integrator 5.2.5.0 installation is complete, install Sterling
B2B Integrator 5.2.5.0 interim fix 3 (5020500_3). See [“Install an interim fix|
[(Windows Cluster)” on page 71| for instructions.
This interim fix (si_52 build 5020500 interimfix_3.jar) is included in the
Sterling B2B Integrator 5.2.5 installation media released in April 2015, but is
not automatically installed. It must be installed separately. In this case, use the
included si_52_build_5020500_interimfix_3.jar file rather than downloading
from Fix Central.

30. Determine whether you need to apply a fix pack or interim fix to the

installation. Refer to [“Install an interim fix (Windows Cluster)” on page 71| for
information.

Installing in a Windows cluster environment with the IBM
Installation Manager in text mode

You can install Sterling B2B Integrator in a Windows cluster environment with the
IBM Installation Manager in a text-based mode that uses a command prompt.

Before you begin

Complete the [“Installation Checklist for a Windows Cluster Environment” on|

|Eage 22.|

Access the JAR file for your installation. The JAR file depends on your operating
system and current version of Sterling B2B Integrator. Refer to the following
websites for the correct JAR file. Consult with your IBM representative to
identify the correct JAR file for your installation.

— Refer to[Fix Central| to see if you must use an interim fix or fix pack JAR file

for the installation.

— Refer to [Passport Advantage| to see if you must use an installation JAR file for
the installation.

If you are using the Standards Processing Engine (SPE) application with Sterling
B2B Integrator, you must install SPE before you install Sterling B2B Integrator.

If you are using the EBICS Banking Server application with Sterling B2B
Integrator 5.2.5, the data encryption for storage within the installation location is
not supported.

About this task

Ensure that the directory one level above the installation directory has the proper
read /write permissions:

The install_dir directory refers to the installation directory where the new
software is installed. Do not use any pre-existing directory name or an old
version of the Sterling B2B Integrator installation directory. If you do, you might
inadvertently overwrite the existing installation. You must create a new
installation directory before you begin the installation.

The parent_install directory is the directory one level above the install_dir
directory.
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If at any time you want to go back and change any input that you previously
entered, you must restart the installation. You can stop the installation by pressing
Ctrl+C. Then, restart the installation.

Procedure
1. Close all open Windows programs and any command prompt windows.

2. From the installation media, copy the compressed installation package to a
location on your desktop.

3. Decompress the installation package.

4. Open the IMSI (Installation Manager) folder that is in the directory structure
that is created when the installation package is decompressed. The directory
includes several IM OperatingSystem.zip files.

5. Decompress the IM_Win.zip file. This action creates a new IM_Win folder.
6. Open the new IM_Win folder in a command prompt window.
7. Enter the following command to start the installation:

installc.exe -c

Note: Extra memory settings can be specified for the Installation Manager by
adding the following parameters to the installation command.

* -DmemoryMax=-Xmx3072m
* -DmemoryMin=-Xms1024m
The Installation Manager (text mode) starts.
An [X] next to an option number indicates that option is selected.

8. Select the package to install. Press Enter to accept the default selection.
The appropriate package is selected by default.

9. Review the license agreement. Enter:
* 1 to view the Sterling B2B Integrator license agreement.
* A to accept the agreement.
* D to not accept the agreement.

If you do not accept the agreement, the installation process is canceled.
The screen refreshes with an [X] in front of your selected option. Press Enter
to continue.
10. Specify the path to the Sterling B2B Integrator installation directory.

This directory is referred to as install_dir. Below the installation directory,
the installer creates a directory that is named install that contains the
installation files. You can modify the default path by entering M and entering
the appropriate path.

Important: For node 2 and higher, you must specify a different installation
directory.
The screen refreshes with an [X] in front of your selected option. Enter N to
continue.

11. At the IBM B2B Sterling Integrator prompt, press Enter to accept the default
value of Sterling Integrator.

12. Enter the full path of your JDK directory.

13. Select the licenses and features to install. Enter[Y]es to select a feature or [N]o
to decline a feature when prompted. You are prompted for each of the
following licenses:

* IBM Sterling B2B Integrator and/or IBM Sterling File Gateway
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14.
15.
16.

17.

18.

19.
20.

21.

22.

* FIPS Module
— FIPS Compliance Mode (Must enable FIPS Module)
* (5.2.5 and higher) NIST 800-131a Compliance Mode
For this feature, you are prompted to enter a number for the option.
— off (default value)
— transition
— strict
* AS2 Edition Module
* Financial Services Module
* EBICS Banking Server Module

* (5.2.5 and higher) SPE Integration Module (Requires pre-install of SPE,
WTX optional)

If you select the SPE option, you are prompted for the following
information:

— SPE installation directory

— (Optional) WebSphere Transformation Extender (WTX) installation
directory

- SPE Ul port

For more information, see the documentation for the integration of Sterling
B2B Integrator and SPE.

Note: Select only the licenses/features that are defined by your IBM contract.
If you are unsure which to select, the installation can proceed without making
a selection and complete successfully. Startup and operation of the software,
however, requires one of the licenses to be selected. See License Modification to
apply licenses post-install.

Note: Sterling File Gateway requires extra installation steps. See the Sterling
File Gateway Installation Guide.

Note: If you are upgrading to Sterling B2B Integrator version 5.2.4 from a
previous 5.2.x release, you must manually install the EBICS client. For more
information about installing the EBICS Client manually, see the EBICS Client
User Guide.

Enter the full path to your JCE policy file.
Select the JAR file to use.

Enter an explicit IP address or host name to override the default value of
Tocalhost.

Enter the initial port number. The default value is 8080.

Important: For node 2 and higher, you must specify a different port number.
Enter your system passphrase.

The passphrase is not hidden. It appears in dot format on your screen.

Enter your system passphrase again to confirm it.

Enter the email address to which you want system alert messages and other
administrative notices sent.

Enter the SMTP mail server host name that you want to use for system alert
messages and other administrative notices.

Enter the number of the database vendor as listed in the display:
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[1] DB2

* [2] Oracle

+ [3] MySQL

(5.2.3 - 5.2.4.2) [4] MSSQL2005
(5.2.5 and higher) [4] MSSQL2012

23. (Skip for MySQL) Specify whether this installation is for a cluster node 2 or
higher. Enter [N]o.

* On node 1, enter [N]o.

* On node 2 and higher, enter [Y]es.

24. (Skip for MySQL) Specify whether you want to apply the database schema
automatically:

» To automatically apply the database schema, enter [Y]es.

* To manually create the database schema, enter [N]o and continue with the
remaining installation steps.

Note: After the installation starts, it runs for a short time and stop without
error. When the installation stops, you must perform later in this
procedure.

25. Configure your database by entering the following information:

* User name.

* Password (and confirmation).
This password is not hidden. It appears in dot format on your screen.

* Catalog name.

* Host name.

* Host port number.

* (Oracle, Microsoft SQL Server, and MySQL only) Absolute path and file
name for one JDBC driver.

* (DB2 only) Absolute paths and file names for two JDBC drivers.
Use the Type-4 JDBC driver. This type of driver converts JDBC calls into the

network protocol that is used directly by DB2, allowing a direct call from
Sterling B2B Integrator to the DB2 server.

* (Oracle only) At the What Data type would you like to use? prompt,
choose a data type for binary data (BLOB or Long Raw).

— To use caching for BLOB (binary large object) columns, enter BLOB. You
can significantly improve performance by enabling the cache on the
BLOB data object in Oracle. For more information, see the documentation
for slow performance in Oracle.

— To use the Long Raw data type, enter Long.

The Installation Manager automatically tries to validate the JDBC driver.

The Installation Manager must successfully validate the connection to the
database before you can continue with the installation. If there is a validation
failure, you can view the system log to determine more information about the
failure. Perform the following tasks:

a. Identify the location of the user’s application directory. Select Start > Run
and enter %APPDATA%.

b. Open the user’s application directory: local_path\IBM\Installation
Manager\logs

c. Open the index.xml file in a browser.

40 Windows Cluster Environment Installation:



26.

27.

28.

29.

d. Identify the log file that is based on the time stamp of when you started
your installation.

e. Click the installation file to view a listing of errors that occurred during
that installation.

Specify whether this installation is an upgrade from a prior version. Enter
[N]o.

Specify whether you want to use the verbose installation option. Enter the
appropriate option for this installation:

* [Y]es.
* [N]o

Confirm your entry by pressing Enter.

Type values in the following fields. You must manually type a value, even if
you are using the default value.

* Number of Processor Cores

* Physical Memory (MB) allocated to Sterling B2B Integrator
After typing in the values, press Enter.

Review the information and select your next course of action:

* To generate an installation response file with the settings that you specified
in the Installation Manager, enter G.

* To start the installation, press Enter to select the default value of I.
* To return to a previous option, enter B.

* To cancel the installation, enter C.

If you selected I, the installation begins.

If you did not select the option to apply database schema automatically, the
installation stops and you must perform extra steps to complete the
installation with manual DDL statements:

a. Open your install directory.
b. Locate the Install1SI.log file and open it with a file editor.
C. Search the file for these error messages:

* <SI Install>/repository/scripts/EFrame_IndexAdds.sql must be
applied to the database.

e <S§I Install>//repository/scripts/EFrame_Sequence.sql must be
applied to the database.

e <§I Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Note: If you do not find these error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script for your database. These changes might include
changing the SQL delimiter or adding table space options.

e. Log in to your database as the DB schema user.
f. Run the SQL files manually in this order:

Important: When you are running the scripts, you must run the SQL
scripts in the specified order.

* EFrame_IndexDrops.sql
* EFrame_TableChanges.sql
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30.

31.

32.

* EFrame_IndexAdds.sql

* EFrame_TextIndexAdds.sql

» EFrame_Sequence.sq]l

* EFrame_TextIndexModify.sql
* EFrame_TextIndexUpdates.sql
* EFrame_TextIndexUpgrade.sql
* EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names that are
based on the name of the installation node. Table generation is not
included in these scripts, but is performed automatically during the initial
startup of Sterling B2B Integrator or when a new cluster node is added.
Table generation might fail if security restrictions reduced the Sterling B2B
Integrator database user permissions. To avoid this issue, ensure that the
DBADM role permissions are enabled during the initial startup. If further
issues arise, contact IBM customer support.

g. Exit from the database.
h. Open the parent directory of the installation directory.

i. Delete (or Rename as a backup) the Sterling B2B Integrator installation
directory.

j. Restart the installation wizard and provide the same installation options
that you provided before you cleared the Apply database schema
automatically check box.

Installation information can be found in the InstallSI.log file. The
installation automatically continues. When the installation is finished, the
system displays the following message:

The install completed successfully
Press Enter to select Finish.

Check the Instal1SI.Tog file to verify that all of the components were
installed properly.

To install each additional node see step

The Installation Manager dialog box appears with an Installed Packages
window displayed. This window is an informational message that informs
you that you have an instance of Sterling B2B Integrator already installed.
Click Continue to continue with your node 2 and higher installations. For
node 2 and higher, follow the same steps as you did for node 1, until the This
installation is for a cluster node 2 or higher prompt. At that prompt, enter
[Y]es.

If you installed multiple nodes on the same server or used different base ports
for node 2 onward, you need to complete the following steps:

Step

Action Your Notes

Open the install_dir\install\properties directory for node
1.

In the noapp.properies_platform_ifcresources_ext file,
record the value for the multicastBasePort parameter.

In thejgroup_cluster.properties file, record the values for
the mcast_port parameters of the property_string and
lock.protocolStack properties.

For each subsequent node, you need to perform the remaining
steps.
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Step |Action Your Notes

5 Open the \install_dir\install\properties directory for each
node (node 2 and higher).

6 In the noapp.properies_platform_ifcresources_ext.in file,
update the value of the multicastBasePort parameter to
match the value for node 1.

For example, replace the string 8MULTICAST_NODE_PORT1; with
the port number 45460:

* (before) multicastBasePort=8MULTICAST_NODE_PORT1;
e (after) multicastBasePort=45460

7 In the jgroups_cluster.properties.in file, update all
occurrences of mcast_port to match the values for node 1.

8 After you updated the attributes for all of the nodes, enter the
following command for node 2 and higher:

\install_dir\install\bin\setupfiles.cmd

33. (This step applies only if you are installing Sterling B2B Integrator 5.2.5.0.)

After the Sterling B2B Integrator 5.2.5.0 installation is complete, install Sterling
B2B Integrator 5.2.5.0 interim fix 3 (5020500_3). See |“Install an interim fix|
[(Windows Cluster)” on page 71 for instructions.
This interim fix (si_52_build_5020500_interimfix_3.jar) is included in the
Sterling B2B Integrator 5.2.5 installation media released in April 2015, but is
not automatically installed. It must be installed separately. In this case, use the
included si_52_build_5020500_interimfix_3.jar file rather than downloading
from Fix Central.

34. Determine whether you need to apply a fix pack or interim fix to the
installation. Refer to [“Install an interim fix (Windows Cluster)” on page 71| for
information.

Silent installations

The silent installation method automates part of the installation process and limits
your manual interaction with the installation program. This is useful for doing
multiple installations.

To use the silent installation method, you will need to first create a silent install file
using a text editor.

Create the Silent Installation File (Windows Cluster)
About this task

The following entries correlate to prompts in the Install Using the IBM Installation
Manager procedure. Create a silent installation file with the following variables:

Note: Special characters need to be proceeded by a \ (backslash) esc character.

Entry

Description

ACCEPT_LICENSE

(Required) Indicates if the user accepts the license agreement.

Default: YES

JVM_LOC

(Required) Full path to JDK directory.
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Entry

Description

LICENSE_FILE_PATH

(Required) Full path to Core_License.xml.

The Core_License.xml file is located on the same media as the install wizard
jar and the installation jar.

Attention: If you are installing or upgrading Sterling B2B Integrator to
version 5.2.4, refer to the section: Extracting the Core License File.

LICENSE_FILE_#

(where # is a number between 1
and 99)

(Required) This is required for each license you install. You need to add an
entry for each license file to the silent install file. The LICENSE_FILE
numbering (#) does not need to be sequential.

For example:

LICENSE_FILE_1= SI_SFG_License.xml
LICENSE_FILE_2= Fin_Serv_License.xml
LICENSE_FILE_3= SI_SFG_FIPS_License.xml
LICENSE_FILE 4= AS2_License_.xml

LICENSE_FILE_5= EBICS_License_.xml

SI_LICENSE_AVAILABLE

(Optional) Indicates if a license is being passed in and is required for the
installation.

Default: YES

JCE_DIST_FILE

(Required) Full path to unlimited strength JCE policy file. If present, this file
will overwrite the JCE file in the JDK.

INSTALL_DIR

(Required) Directory that includes the bin subdirectory (where many
commands are stored) and the properties subdirectory (where many
properties are stored).The INSTALL_DIR property cannot point to a

pre-existing directory, or the installation will fail.

REINIT_DB (Required) Indicates if database should be initialized.
* For node 1 of a cluster, this property is true.
* For node 2 and higher of a cluster, this property is false.
Default: true
CLUSTER (Required) Indicates if this is the second or higher node of a cluster

installation.

Valid values:
* true - This is the second or higher node of a cluster installation.

+ false (default) - This is the first node of a cluster or a single node
(non-cluster) installation.
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Entry

Description

INSTALL_IP

(Required) Host name or IP address.

Valid values:
* localhost (default)
* Your IP address or host name

If you are installing Sterling B2B Integrator on VMware, provide the IP
address of the virtual machine, not the IP address of the VMware host. For
example, if 10.251.124.160 is the IP address of the VMware host and
10.251.124.156 is the IP address of the Windows 2003 server it is hosting, you
should use 10.251.124.156 as the correct IP address to install Sterling B2B
Integrator.

Note: Sterling B2B Integrator does not support IPv6 installation on Windows.
Before applying an IPv6 address, see IPv6 Capabilities section in System
Requirements guide.

You must install using a host name, not an IPv6 address, otherwise the
Lightweight JDBC adapter and Graphical Process Modeler (GPM) will not
work.

PORT1

(Required) Base port for ASI server. Ports are assigned consecutively from this
port.

Default: 8080

APSERVER_PASS

(Required) Passphrase used to secure all encrypted data in database.

SI_ADMIN_MAIL_ADDR

(Required) E-mail address for the administrative user.

Example: abc@xyz.com

SI_ADMIN_SMTP_HOST

(Required) Valid SMTP host through which the system can e-mail the
administrative user.

Example: mail.xyz.com

FIPS_MODE

(Optional) Indicates if you are using FIPS (Federal Information Processing
Standards) mode.

Valid values:
* true - Enable FIPS mode.
* false (default) - Disable FIPS mode.

DB_VENDOR

(Required) Database vendor.

Valid values:

* Oracle

* MSSQL2005 (use this value for Microsoft SQL 2005 and 2008)
* DB2

* MySQL (default)

DB_CREATE_SCHEMA

(Required) Indicates if you want the database schema automatically created.

Valid values:
* true (default) - Automatically create the schema.

* false - Manually create the schema. This is not a valid choice for MySQL.
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Entry Description
DEBUG (Optional) Records events that occur during the installation in InstallSLlog file.
Valid values:
* true - records events that occur during the installation.
* false (default) - does not record the events that occur during installation.
DB_USER (Required) Database user name.
Example: abed_123_1
DB_PASS (Required) Database password.
DB_DATA (Required) Database catalog name.
DB_HOST (Required) Database host name.
Default: localhost
DB_PORT (Required) Database port.
DB_DRIVERS (Required) Full path to JDBC driver files. If DB_VENDOR is:

* Oracle or MSSQL, specify one driver.
* DB2, specify two drivers.

If you specify more than one driver, use colons (:) to separate the file names.

Examples:
* JDBC_driver_dir\db2jdbc.jar
* JDBC_driver_dir\db2_1_jdbc.jar:JDBC_driver_dir\db2_2_jdbc jar

ORACLE_USE_BLOB

(Required if DB_VENDOR=Oracle) Indicates the data type to use for caching.
true (default) - BLOB (binary large object)

Note: The value ORACLE_USE_BLOB=false is not allowed.

MSSQL2005

(Required for Microsoft SQL Server 2005) This attribute is case-sensitive.
* Set this attribute to the default value of true.

* (All other servers) Do not include this attribute.

JDK64BIT

(Optional) Indicates if a 32-bit or 64-bit JDK is being used. Refer to the System
Requirements to determine the type of JDK for your operating system.

Valid values:
* true (default) - 64-bit
* false - 32-bit

Icons

(Required) Indicates whether to create a desktop icon for accessing Sterling
B2B Integrator.

Valid values:
* true - Create a desktop icon.

+ false (default) - Do not create a desktop icon.

If you created the desktop icon and are using Windows Server 2008, you need
to complete the Configure the Desktop Icon for Windows Server 2008 task after
the installation is complete.

The following entries do not directly correlate to prompts in the installation
procedure. Use these entries to customize or document your installation.
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Entry

Description

DB_DRIVERS_VERSION

(Optional) Free form version string for JDBC driver. This is informational only.

Example: 8_1_5

LOAD_FACTORY_SETUP

(Optional) Indicates whether factory setup should be loaded during installation.
To manually set LOAD_FACTORY_SETUP to false after an installation where
LOAD_FACTORY_SETUP=true (the default value), change
LOAD_FACTORY_SETUP to false in sandbox.cfg file.

Valid values:
* true (default).- loads factory setup during installation.

* false - does not load factory setup during installation. Run loadDefaults
command after installation.

CONFIG_GS

(Optional) Indicates whether integration with Sterling Gentran:Server® should
be configured.

Default: No

NO_DBVERIFY

(Optional) Valid values are true or false. When set to true during installation
and installservice, dbverify will not be run.

This means that the Sterling B2B Integrator will not generate DDL to make the
database like the XML entity repository.

Install Using a Silent Installation File (Windows Cluster)
You can install Sterling B2B Integrator in a Windows cluster environment with the
IBM Installation Manager with a silent installation file.

About this task

Before you begin, you should have already created the silent install file.

To install Sterling B2B Integrator in windows cluster environment using a silent
installation file:

Procedure

1.
2.

Close all open Windows programs and any command prompt windows.

From the installation media, copy the compressed installation package to a

location on your desktop.

Uncompress the installation package.

Set up your silent installation file and record its location.
To start the installation, use one of the follow methods:
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For Windows Server 2003 or earlier For Windows Server 2008 or later

* Open a command prompt window (from the Run Complete the following steps:
dialog box). * Click Start.

* Enter * Right-click Command Prompt and select Run as
\absolutePath\bin\java -Xmx512m -jar administrator.
\absolutePath\SI_<build_number>.jar -f The Administrator: Command Prompt dialog box is
\absolutePath\SilentInstallFile displayed.

* Enter

\absolutePath\bin\java -Xmx512m -jar
\absolutePath\SI _<build number>.jar -f
\absolutePath\SilentInstallFile

The installation begins. The program verifies support for your operating
system and JDK. You can follow the progress of the installation on screen.

When the installation is finished, the system displays the following message:
Installation has completed successfully.

Note: Select only the licenses/features that have been defined by your IBM
contract. If you are unsure which to select, the installation can proceed
without making a selection and will complete successfully. Start up and
operation of the software, however, requires one of the licenses to be selected.
See License Modification to apply licenses post-install.

Note: Sterling File Gateway requires additional installation steps. See the
Sterling File Gateway Installation Guide for more information.

6. (Skip this step if you are applying database schema automatically.) If you are
going to manually create the database schema, the install starts and runs for a
short time and stops without error.

Note: After the installation stops, you must perform these additional steps to
complete the installation with manual DDL statements:

a. Navigate to your install directory.
b. Locate the InstallSLlog file and open it with a file editor.
C. Search the file for these error messages:

* <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be applied
to the database.

* <SI_Install>/ /repository/scripts/EFrame_Sequence.sql must be applied
to the database.

* <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Note: If you do not find the above error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script and make changes appropriate for your database. This
may include changing the SQL delimiter or adding tablespace options.

e. Log in to your database as the DB schema user.
f. Execute the SQL files manually in this order:
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10.

Note: When you are executing the scripts, it is important to execute the
SQL scripts in the specified order.

* EFrame_IndexDrops.sql

* EFrame_TableChanges.sql

* EFrame_IndexAdds.sql

* EFrame_TextIndexAdds.sql

* EFrame_Sequence.sql

* EFrame_TextIndexModify.sql
* EFrame_TextIndexUpdates.sql
* EFrame_TextIndexUpgrade.sql
* EFrame_Static.sql

Important: ActiveMQ uses dynamically generated table names based on
the name of the install node. Table generation is not included in the above
scripts, but is performed automatically during the initial start of Sterling
B2B Integrator or when a new cluster node is added. Table generation may
fail if security restrictions have reduced the Sterling B2B Integrator
database user permissions. To avoid this issue, ensure that the DBADM
role permissions are enabled during the initial startup. If further issues
arise, contact IBM customer support for guidance.

g. Exit from the database.

h. Navigate to the parent directory of install_dir.

i. Delete (or Rename as a backup) the Sterling Integrator install directory.

j. Restart the installation wizard and provide the same installation options
you provided before including clearing the Apply database schema
automatically check box.

Check the InstallSI.log to verify all the components have installed properly.

If you are installing nodes on separate machines, copy the silent install file for

node 1 into a new silent install file and then set REINIT DB=false and set

CLUSTER=true. This REINIT_DB=false prevents the database from being

re-initialized. After you have the silent install files for node 2 and higher,

proceed to Step 8.

If you are installing multiple nodes on the same machine, copy the silent

install file for node 1 into a new silent install file and then set

REINIT_DB=false, set CLUSTER=true, use a different installation directory for

each node (INSTALL_DIR) and make sure that the initial port for each node is

100 port numbers higher or lower than node 1. After you have the silent

install files for node 2 and higher, proceed to Step 8.

To start the installation of nodes 2 and higher of the cluster:
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For Windows Server 2003 or earlier For Windows Server 2008 or later

* Open a command prompt window (from the Run Complete the following steps:
dialog box). * Click Start.

* Enter * Right-click Command Prompt and select Run as
\absolutePath\bin\java -jar administrator.
\absolutePath\SI_<build_number>.jar -f The Administrator: Command Prompt dialog box is
\absolutePath\SilentInstallfile - cluster displayed.

* Enter

\absolutePath\bin\java -jar
\absolutePath\SI _<build number>.jar -f
\absolutePath\SilentInstallFile - cluster

11. If you installed multiple nodes on the same machine or used different base
ports for node 2 onward, you need to complete the following additional steps:

Step |Action Your Notes
1 Navigate to \install_dir\install\ properties for node

1.
2 In the noapp.properies_platform_ifcresources_ext

file, record the value for multicastBasePort.

3 In the jgroup_cluster.properties file, record the
values for the mcast_port parameters of the
property_string and lock.protocolStack properties.

4 For each subsequent node, you need to perform the
remaining steps.

5 Navigate to \install_dir\install\properties for each
node (node 2 and higher).

6 In the noapp.properies_platform_ifcresources_ext.in
file, update the value of the multicastBasePort to
match the value for node 1.

For example, replace the string
&MULTICAST_NODE_PORT1; with the port number
45460

* (before) multicastBasePort=
&MULTICAST_NODE_PORT1;

* (after) multicastBasePort=45460

7 In the jgroups_cluster.properties.in file, update
all occurrences of mcast_port to match the values
for node 1.

8 After you have updated the attributes for all of the
nodes, enter:

\install_dir\install\bin\setupfiles.cmd for node 2
and higher.

12. (This step applies only if you are installing Sterling B2B Integrator 5.2.5.0.)

After the Sterling B2B Integrator 5.2.5.0 installation is complete, install Sterling
B2B Integrator 5.2.5.0 interim fix 3 (5020500_3). See [“Install an interim fix|
[(Windows Cluster)” on page 71| for instructions.
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13.

14.

This interim fix (si_52 build 5020500 interimfix_3.jar) is included in the
Sterling B2B Integrator 5.2.5 installation media released in April 2015, but is
not automatically installed. It must be installed separately. In this case, use the
included si_52_build_5020500_interimfix_3.jar file rather than downloading
from Fix Central.

Determine whether you need to apply a fix pack or interim fix to the
installation. Refer to [“Install an interim fix (Windows Cluster)” on page 71| for
information.

From the installation directory, install windows services by running the
command installWindowsService.cmd.

Installing version 5.2.x as a fix pack

You can install version 5.2.x as a fix pack on the cluster.

About this task

You need to install the fix pack on each node in the cluster.

Use this procedure to upgrade your clustered 5.2.x system to a later 5.2.x version:

Procedure

ook wn -

10.
11.

Download the fix pack from the installation media.

Verify that the database server is up and ready to accept connections.

Stop the system.

Perform a full backup of the installation directory, including all subdirectories.
Perform a backup of the database.

If you edited any property files, ensure that the associated .properties.in
files have the most current changes. Property files are overwritten with the
contents of the associated .properties.in files during the fix pack installation.

Is the database password encrypted? If Yes, decrypt the password.
To install the fix pack:

* (UNIX) Open the directory where the system is installed and enter the
following command:

./InstallService.sh file name.jar

Attention: Running InstallService.sh removes any previously installed
interim fix to prevent conflicts with what is being installed.

* (Windows) From a command prompt or the Run dialog box, enter the
following command:

C:\install dir\install\bin\InstallService.cmd path\file name.jar

Attention: Running InstallService.cmd removes any previously installed
interim fix to prevent conflicts with what is being installed.

If the fix pack attempts to modify the database schema and the modification
fails, you receive an error message about the failure. The message provides the
error message code from the database and the SQL command that failed. The
failure information is also logged to the system.Tog file and to the patch.log
file.

Press Enter to continue.
If you want to accept the license agreement, enter Y.
Enter the passphrase.
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Information about the fix pack is displayed. After the fix pack is applied, the
following message is displayed:

Deployment to application server successful
12. If you decrypted the database password, re-encrypt the password.
13. Reconfigure the cluster after you install the fix pack.
14. Start the system.

If you are using a perimeter server in the DMZ, review the information on
applying a fix pack to the perimeter server.

Configure the Sterling B2B Integrator Desktop Icon for
Windows Server 2008

User Access Control (UAC) is a security component in Windows Server 2008. It
affects the installation and the daily processing for Sterling B2B Integrator.

About this task

If you enable the UAC, it affects the installation process and the daily processing
for Sterling B2B Integrator. If you disable the UAC, which requires a reboot, the
installation process and daily processing for Sterling B2B Integrator remains the
same as in previously supported Windows version.

If you installed or upgraded Sterling B2B Integrator on a Windows Server 2008 and
you created a desktop icon for Sterling B2B Integrator, you must complete this task
in order for the desktop icon to work.

Procedure

1. Right-click on the Sterling B2B Integrator desktop icon.
2. Click Properties.

3. In the Shortcut tab, click Advanced.

4. Select the check box for Run as Administrator.

5. Click OK to apply the changes to Advanced Properties.
6. Click OK.

Validate the Installation

Validation of the installation checklist in a cluster environment

As part of the installation, you need to run several tests to ensure that the software
installation was successful.

Validate Installation Task Completed

Configure the Nodes in the Cluster.

Verify the Cluster Environment Settings in Property Files.

Start the Cluster.

Access Sterling B2B Integrator.

Validate the Installation (Sample Business Process).

Verify the Cluster is Running from the User Interface.

N | |G| N~ #H*

Stop a Node (Hard Stop or Soft Stop) or Stop the Cluster.
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Verifying the cluster environment settings in the properties
files

Procedure

To verify the cluster environment is correct, check these properties file settings on
node 2:

1. Verify that the value CLUSTER=true is in the sandbox.cfg property file.

2. Verify that the value CLUSTER=true is in the centralops.properties property
file.
3. Verify that the value CLUSTER=true is in the noapp.properties property file.

4. Verify that the value cluster_env property=true is in the ui.properties
property file.

Configure the Nodes in Windows Cluster

The first time that you configure a cluster, you need to use the startCluster
command with true option (startCluster.cmd nodeNumber true). Initial
configuration is the only time that you need to use the startcluster command.

About this task

However, if you should need to use the command again, use the startcluster
command with the false option (startCluster.cmd nodeNumber false). The false
option prevents any configuration changes from affecting the system, especially
after installation of a fix pack or interim fix.

To configure the nodes in a Windows cluster environment, you need to perform
the following task for each node, starting with node 1:

Procedure

1. Navigate to \install_dir\install\bin for the node using one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter startCluster.cmd <nodeNumber> <true or false> Where
<nodeNumber> is the number of the node, true performs database updates and
false prevents database updates. For example for node 1, enter
./startCluster.cmd 1 true.

3. Enter startWindowsService.cmd. Perform this step for each node. The final
startup processes run, concluding with the following message: Open your Web
browser to http://host:port/dashboard where host:port is the IP address and
port number on your system.

4. Record the URL address so that you can access Sterling B2B Integrator.
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Starting Sterling B2B Integrator in a Windows cluster
environment
After you run the upgrade software, you can start Sterling B2B Integrator.

Before you begin

If you are starting Sterling B2B Integrator after you upgrade the application from
version 5.1.0.4 to 5.2.5, change the values of the following properties in the
centralops.properties file to 600. This action prevents the
StartWindowsService.cmd command from timing out before Sterling B2B Integrator
starts. The centralops.properties file is in the install dir\install\properties
directory.

* OpsServer.commandTimeout

* PassPhrase.urlTimeout
About this task

Perform this task for each node in the cluster, starting with node 1.

Procedure

1. Open the \install_dir\install\bin directory with one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter startWindowsService.cmd.
3. Enter your passphrase.

4. The final startup processes run, concluding with the following message: Open
your Web browser to http://host:port/dashboard

Where host:port is the IP address and port number where Sterling B2B
Integrator is located on your system.

Depending on system load, it might take several minutes for the UI to be ready.
5. Record the URL address so that you can access Sterling B2B Integrator.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for node 1.

Note: The restart parameter can be used on only node 1. It cannot be used on
any other nodes.

For example:
For node 1, enter:

startWindowsService.cmd restart
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For node 2 and higher, enter:

startWindowsService.cmd

Accessing Sterling B2B Integrator

You can access Sterling B2B Integrator through a web browser.

Procedure

1.

Open a browser window and enter the address that is displayed at the end of
the start.

On the login page, enter the default user ID and password. The default login is
at an administrative level. One of your first tasks as an administrator is to
change the administrative password and to register other users with other
levels of permission.

Validating the installation with a sample business process

You can validate the installation by testing a sample business process.

Procedure

1.

From the Administration Menu, click Business Process > Manager.

2. In the Process Name field, type Validation_Sample_BPML and click Go!

SN

Click execution manager.
Click execute.

Click Go! The Status: Success message is displayed on the upper left side of
the page.

Verifying from the user interface that the cluster is running

You can use the user interface to verify that the cluster is running, including queue
information and adapter status.

Procedure

1.

From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the Queue information for each node.

From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the JNDI Tree for each node.

From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the host, state, status, adapters, and memory usage
information for each node.

From the Administration Menu, click Operations > System > Troubleshooter.
Ensure you can view the adapter status for each node.

Stop a Node in the Windows Cluster Configuration (Hard Stop)

You can stop a single node Sterling B2B Integrator in a Windows cluster
environment.

About this task

To run a hardstop, perform this task for each node:
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Procedure

1. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter StopWindowsService.cmd.

3. Enter your passphrase. You can also perform this task by selecting Operations
> System > Troubleshooter. Then click the shutdown link for the node you
want to stop.

Stop Sterling B2B Integrator (Windows Cluster)

You can stop the entire cluster in a Windows environment from the
Administration menu.

About this task

To stop the entire cluster in a Windows environment:

Procedure

1. From the Administration Menu, select Operations > System > Troubleshooter.
2. Click Stop the System and wait for shutdown to complete.

Stop Sterling B2B Integrator (Hardstop Windows)

You can stop Sterling B2B Integrator in a Windows environment.

About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter StopWindowsService.cmd. Your should receive a message that services

have been stopped. Services include Noapps, Opsserver, WebDav, and
Database-related service.

Stop Cluster (Softstop Windows)

A soft stop in a cluster environment suspends all scheduled bushiness processes.
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About this task

It is recommended to run the hardstop command on each of the nodes.
To soft stop the cluster:

Procedure

1. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter softstop.cmd. You should receive a message that services have been

stopped. Services include Noapps, Opsserver, WebDav, and Database-related
service.

For more information about the softstop command line options, refer to the
performance management documentation.

Restart the Windows Cluster

You can restart the entire cluster in a Windows environment.

About this task

To restart the entire cluster in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). * Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter startWindowsService.cmd restart.

What to do next

If you need to release all the locks in a cluster and both nodes are down, use the
restart parameter for Node 1.

Note: The restart parameter can only be used on Node 1. It cannot be used on
any other nodes.

For example:

For Node 1, enter:
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startWindowsService.cmd restart

For Nodes 2 and higher, enter:

startWindowsService.cmd

Post Installation Configuration

Post Installation Configuration Checklist for Cluster
Environment (Windows)

After you have installed the Sterling B2B Integrator, you need to complete the post
installation configuration checklist. Review all of the tasks, but note, some tasks
may not be required for your system installation.

#

Post Installation Configuration Checklist

Your Notes

For security purposes, change all default user ID
passwords immediately after installation is
completed. See the Update My Account Information
task in the documentation library.

Configure ActiveMQ for a cluster environment.

Download Sterling B2B Integrator Tools.

Determine if you need to modify any Property
Files.

Configure Shared File System as Document
Storage.

Add host[port] from all the nodes to the
jgroups_cluster.property.in for each node.

Configure Customer Overrides File with a
Firewall between Nodes.

JMS Cluster Configuration for Failover

To allow proper JMS execution and failover in the Sterling B2B Integrator cluster
environment, you must configure an external ActiveMQ using the Configure
ActiveMQ for a Cluster Environment task.

The following diagram illustrates how the ActiveMQ can be configured to increase
availability and failover.
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Configure ActiveMQ for a Cluster Environment (Windows)

You can configure ActiveMQ for the Windows cluster environment.

About this task
To configure ActiveMQ for the windows cluster environment:

Procedure

1. Download ActiveMQ 5.2 from http:/ /activemq.apache.org/activemq-520-
release.html for the appropriate OS.

2. Deploy an instance of ActiveMQ 5.2. This can be on the same machine as
Sterling B2B Integrator or on a separate machine.

3. Navigate to \install_dir\install\properties using one of the following
methods:

Windows Cluster Environment Installation (V5.2.3 - 5.2.5)



For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

4. Copy the activemq.xml file to the AMQ conf directory. This file configures the
ActiveMQ to:

* Use failover clustering,

 Use the SI database for storage

* Configures the AMQ port usage

By default, ActiveMQ is configured to listen at the Sterling B2B Integrator base
port + 64 and the ActiveMQ interface will be at base port + 65

(http:/ /server:base port + 66/admin). The port can be changed by editing the
config file directly. The port number must be higher than 1024.

5. Navigate to \install_dir\install\properties using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). * Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

6. On each Sterling B2B Integrator node and each Sterling B2B Integrator
container node, the queue configuration must be re-directed to utilize the
ActiveMQ cluster. In each node, add the following to the
customer_overrides.properties:

For FIFO Processing:

fifo.broker.username=

fifo.broker.password=
fifo.broker.url=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amg_slave_hostname:amq_slave port)

For adapters running in separate JVM containers:

iwfcqueue.username=
iwfcqueue.password=
jwfcqueue.protocol_config=failover: (tcp://amg_master_hostname:amq_master_port,
tcp://amg_slave_hostname:amq_slave_port)

7. Start the ActiveMQ instances. To start ActiveMQ), it is necessary to supply the
activemgq.hostname property with the hostname for the current system. For
example:

activemg.bat -Dactivemq.hostname=ExampleHostname

See http:/ /activemgq.org for additional information about running an ActiveMQ
instance.

8. Start Sterling B2B Integrator.
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Update the sandbox.cfg file for an IPv4 Address
About this task

To update the sandbox.cfg file for an IPv4 address (complete this task for each
node in the cluster):

Procedure
1. Navigate to the properties file directory for each node.
2. Open the sandbox.cfg file.
3. Add the following line to the file.
IPV4ASTACK=true
4. Save and close the file.
5. Navigate to the bin directory for your installation.
6. Run setupfiles.cmd to update your installation.

Download of the Sterling B2B Integrator tools

After you install Sterling B2B Integrator, you can install tools like the Map Editor
and the Graphical Process Modeler (GPM).

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:

* Map Editor and associated standards
* Graphical Process Modeler (GPM)
* Web Template Designer

* (If licensed) MESA Developer Studio plug-ins, including MESA Developer
Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

* (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports

Attention: Conflicting IP addresses can cause problems when you download a
desktop tool.

Property files configuration in a Windows environment

Property files contain properties that control the operation of Sterling B2B
Integrator.

For example, the REINIT_DB property in the sandbox.cfg file controls whether or
not a database is initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize the Sterling B2B
Integrator to suit your business and technical needs. Most property files are in the
\install_dir\install\properties directory.

After installing Sterling B2B Integrator, most property files and scripts do not need
any further configuration for basic operation. However, if you want to customize
any specific operations, for example setting a different logging level - you will
need to edit ( or in some cases, create) certain property or .xml files.

Before changing any property files, refer to the Working with Property Files
documentation for general information about how to work with Property Files.
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Areas where you might need to make specific property files changes after an
installation include:

¢ LDAP user authentication

* Prevention of cross-site script vulnerabilities

* Logging configuration

* Process-specific property file settings

Configure Shared File Systems as Document Storage
(Windows Cluster)

You can configure the shared file systems as document storage in a Windows
cluster.

About this task

To configure the shared file systems as document storage:

Procedure

1.

Navigate to \install_dir\install\properties for the node using one of the
following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box).

¢ Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Open the jdbc.properties.in file.

3. Update the value of the document_dir attribute to point to the shared files
system directory where you store documents.

4. Save and close the file.

5. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box).

e Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

6. Enter setupfiles.cmd.
7. Restart Sterling B2B Integrator.

Add host[port] From all the Nodes to the
jgroups_cluster.property.in for Each Node
You can add the host [port] to the jgroups_cluster.property.in file for each node.
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About this task

Complete this task for both vertical and horizontal clusters. You will need to
complete this task for each node, starting with node 1.

Before you begin, it is important to note that you should never override
mcast_addr in the jgroup_cluster.properties.

To add the host [port] to the jgroups_cluster.property.in file:

Procedure
1. Navigate to the properties file directory for the node.
2. Determine the initial hosts port for each node:

* Navigate to the properties file directory for the node.

* Find the initial_hosts from the jgroups_cluster.property
(initial_hosts=host{port}).

* Record the value from the initial_hosts for each node.
3. Open the jgroups_cluster.property.in file.

4. Add the initial_hosts property to the file. For example, if node 1 is on host1
and node 2 is on host2. For node 1, you would add:

initial_hosts=hostl[portl],host2[port2]

For node 2, you would add:
initial_hosts=host2[port2],host1l[portl]
5. Save and close the file.

Manage Nodes in a Cluster
About this task

You can add or remove nodes in a cluster environment. The following
prerequisites should be considered before performing any modification in the
cluster environment:

* New nodes should have the same range of ports available as the current nodes.

* Sterling B2B Integrator license file should be updated to include the IP address
of the new nodes.

* Directory structure on the new nodes should match with the directory structure
of the existing nodes.

* Perimeter servers should be updated with the new IP addresses to ensure proper
configuration.

* Any adapters, services, or business processes assigned to or scheduled to run on
the node being removed should be assigned to run on other nodes.

Add a Node to the Cluster (Windows)

You do not need to stop the cluster environment while adding a new node.
About this task

To add a node into the cluster:

Procedure

1. Install a new Sterling B2B Integrator node to be added into the cluster during
installation. Ensure that the new node being added is not a primary node.
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2.

3.

4.

Update the jgroups_cluster.properties file and the
jgroups_cluster.properties.in file with the new node details.

Configure the new node by running the startcluster.cmd nodeNumber from the
\install_dir\install\bin directory. The node number should be greater than
1.

You should run startCluster.cmd only after you install Sterling B2B Integrator.
You should not run startCluster.cmd when you restart a Sterling B2B
Integrator instance.

Start the new node.

Remove a Node from the Cluster
About this task

To remove a node from the cluster:

Procedure

1.

Reassign or stop any adapters, services, or business processes assigned to or
scheduled to run on the node being removed.

Perform backup of the node being removed.

Edit the jgroups_cluster.properties file and the
Jgroups_cluster.properties.in file in all nodes to remove the IP address of
the node being removed.

Restart the cluster environment.

Important: Start node 1 with the restart option to update the node
information.

Services and Adapters Associated with Node 1 in a Cluster

The following service and adapters are associated with node 1 in the cluster:

Schedule

FileSystem

CmdLine

CDServerAdapter

CDAdapter

CDRequesterAdapter
CEUServerAdapter

HttpServerAdapter
B2B_HTTP_COMMUNICATIONS_ADAPTER
HTTP_COMMUNICATIONS_ADAPTER
HTTPClient Adapter

FTPClientAdapter

FtpServerAdapter

SFTPClientAdapter

The following services have storage set to database:

HttpServerAdapter
CEUServerExtractrServiceType
CDSERVER_ADAPTER

The default storage for all of the workflows is set to database.

64 Windows Cluster Environment Installation:



Configure Customer Overrides File with a Firewall between
Nodes
About this task

If you have configured a firewall between nodes that blocks ports outside of the
port range assigned to Sterling B2B Integrator, perform the following task on all
nodes:

Procedure
1. Navigate to the Sterling B2B Integrator installation directory.

2. Navigate to the properties directory and locate (or create, if necessary) the
customer_overrides.properties file.

3. Open the customer_overrides.properties file using a text editor.
4. Add the following properties:

noapp.jnp_host= <host_name>
noapp.Jjnprmiport=<port_number_1>
noapp.Jjnprmiport2=<port_number_2>
noapp.useSocketFactories=true
noapp.jndirmiport=<port_number_3>
ops.jnp_host= <host_name>
ops.Jjnprmiport=<port_number_1>
ops.useSocketFactories=true
ops.jndirmiport=<port_number_2>
ops.Jjnprmiport2=<port_number_3>

This increases the number of threads used by the system.
5. Save and close the customer_overrides.properties file.
6. Stop Sterling B2B Integrator and restart it to apply the changes.

System Maintenance

Cluster Maintenance Overview

You might need to perform system maintenance activities such as applying a fix
pack, performing a checksum, or generating a fix pack change report.

From time to time, you may need to perform system maintenance activities. These
activities might include any or all of the following;:

* Applying a fix pack

* Applying an interim fix

* Performing a Checksum

* Generating a Fix Pack Change Report
* Adding or removing a license

Applying a fix pack or interim fix in a Windows Cluster
environment

Occasionally, you need to apply a fix pack or an interim fix to Sterling B2B
Integrator.

From time to time, you will need to apply either a fix pack or an interim fix to
your Sterling B2B Integration installation:

* All nodes in the cluster must be on the same fix pack. You must stop all nodes
in the cluster before installing a fix pack, then install the fix pack on each node.
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Attempting to apply a fix pack while part of the cluster is running should only
be done with the advice of IBM Customer Support.

* Fix packs contain cumulative fixes for a specific version of Sterling B2B
Integrator. Because each fix pack contains the fixes from previous fix packs, you
only need to install the most recent fix pack. You should periodically check the
web site to verify that you have the most recent fix pack.

* An Interim fix is one or more fixes applied to a specific existing fix pack.

It is possible to apply fix packs to nodes while other nodes are processing.
However a fix pack containing any of the following, requires the entire cluster to
be down:

¢ Critical cluster functionality
* Engine-related changes
* Changes to the database

You can preserve your custom changes to system resources (like workflow
definitions and maps) when you update your system. During updates, the system
can identify when you make a custom change versus when the system makes a
change through an upgrade or fix pack.

When a fix pack, installation or upgrade is performed, a baseline record of system
resources is created. This baseline is not affected by any subsequent customer
changes. When another fix pack is installed, the resources in this baseline are
compared to the resources in the existing system. If a baseline and existing
resource are not the same, it means that the existing resource was customized and
is not overwritten by the fix pack.

During an update, the baseline is updated with new system resource information,
but not with custom changes to resources.

Determine If You Need to Apply a Fix Pack (Windows)

Fix Packs contain cumulative fixes for a specific version of Sterling B2B Integrator.
About this task

Fix packs are available on the IBM Fix Central web site. Because each fix pack
contains the fixes from previous fix packs, you only need to install the most recent
fix pack.

Note: During installation, the dbVerify utility compares the list of standard indexes
with those present in the database and drops the custom indexes. You should
recreate the custom indexes after the installation is complete.

Fix packs are named using the following naming convention:

si_<release number>_<build number> jar

Information about a fix pack is located in a PDF file with a similar name. The
naming convention for PDF files is:

si_<release number>_<build number>.pdf

Before you install the fix pack, review the following items:
* Preserve your custom changes to system resources.
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* The installation may use one or more property override files. These files will be
named propertyFile_patch.properties. Do not alter these files.

* Property changes made directly in *.properties or *.properties.in files may be
overwritten during the installation. Properties overridden using the
customer_overrides.properties file are not affected. IBM recommends that you
maintain property file changes using (when possible) the
customer_overrides.properties file. For more information about this file, refer to
the property file documentation.

* If you edited any of the cdinterop files, you must back them up before applying
the fix pack. The cdinterop files do not have initialization ( *.in ) files. After
applying the fix pack, use the backup version of the files in your installation.
These files include the following files: cdinterop-proxy-records.properties;
cdinterop-spoe-auth.properties; cdinterop-spoe-policy.properties; and
cdinterop-user-records.properties.

* Information about the installation is automatically logged to
\install_dir\install\logs\InstallService.log.

* If you need to rollback a fix pack, see the Fix Pack Change Report.

Preserve Custom Changes in Windows Cluster Environment

As part of a default cluster configuration, certain values in the database for service
or adapter configurations, and default document storage, need to be updated to
get the cluster working.

About this task

The default settings do not include a shared or mounted file system with a line of
sight from all cluster nodes. Certain service or adapter configurations are forcibly
deployed on node 1 and the default document storage type is set up to "Database"”
for all business processes.

To keep these custom configuration changes from being overwritten, you can run
the following cluster configuration script:

startCluster.cmd nodeNumber true/false

Where:

* nodeNumber is the cluster node number
* True performs database updates

* False prevents data base updates.

The first time you configure a cluster, you need to have the option set to true.
After the first configuration, you can use the false option. The false option prevents
any configuration changes from affecting the system, especially after installation of
a fix pack or interim fix.

Install a critical fix pack to the cluster (Windows)
Fix packs are used to update Sterling B2B Integrator.

About this task

To install a critical fix pack to the entire cluster in a Windows environment (where
you need to stop the entire cluster):

Procedure
1. Navigate to the IBM Fix Central web site.
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Download the most recent fix pack file for your version of Sterling B2B
Integrator and record the absolute path to the downloaded file. Do not
rename the file. If you use FTP, you must use Binary mode.

3. Verify that the database server is up and ready to accept connections.

4. Stop all the nodes in the cluster.

5. Perform a full backup of the Sterling B2B Integrator installation directory,
including all subdirectories.

6. Perform a backup of the database.

7. 1If you edited any property files, ensure that the associated properties.in files
have the most current changes. Property files will be overwritten with the
contents of the associated properties.in files during the fix pack installation.

8. Is the database password encrypted? If Yes, decrypt the password.

9. Close all command prompt windows.

10. Navigate to install_dir for the node (starting with node 1), using one of the
following methods:
For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

11.

12.
13.
14.

15.

Enter: InstallService.cmd <path>\si_<version>_sp_0_fix
pack <number> <app _server>.jar

where:
<path> is fully qualified path to maintenance fix pack file
<version> is Sterling B2B Integrator version
<number> is fix pack number
<app_server> is Application server

If the fix pack attempts to modify the database schema and the modification
fails, you will receive an error message about the failure. The message will
provide the error message code from the database and the SQL command that
failed. The failure information is also logged to the system.log file (in the
\install_dir\install directory) and to the fix pack.log file.

Attention: Running InstallService.cmd removes any previously installed
interim fix to prevent conflicts with what is being installed.

Press Enter to continue.

If you want to accept the license agreement, enter Y.

Enter the passphrase.

Information about the fix pack is displayed. After the fix pack has been
applied, the following message is displayed:

Deployment

to application server successful.

After you have completed the fix pack for node 1, you can now perform the
steps for node 2 and greater. For node 2 and greater, you must update the
value of REINIT_DB to false. When REINIT_DB is false, database updates are
not applied during each fix pack. The REINIT_DB attribute is in the
\install_dir\install\properties\ sandbox.cfg file.
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16. Repeat Steps 10 to 14 to apply the fix pack to each node.
17. If you decrypted the database password, re-encrypt the password.

18. For each node, navigate to the install_dir and start the nodes, using one of the
following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

* Open a command prompt window (from Complete the following steps:
the Run dialog box). * Click Start.

* Enter startCluster.cmd nodeNumber. * Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.
* Enter startCluster.cmd nodeNumber.

19. Restart Sterling B2B Integrator.

If you are using a perimeter server in the DMZ, you will to review the
information on apply a fix pack to the perimeter server.

Apply a fix pack (rolling update) - Windows
Use this topic if you want to install a fix pack on a clustered installation, stopping
one node at a time.

Before you begin

You can only use this update method if there are no database changes in the fix
pack. Check for the following items:

* Database update information in release notes

* DB partitions - you should undo partitions prior to applying a fix pack
* Schema differences or alterations

* Corrupted or missing database indexes

* Oracle 11g issues with INT vs. NUM fields - you should update your driver and
patch for Oracle 12g.

You should always perform a full backup of the software and your database prior
to applying a fix pack or interim fix.

About this task
Use this procedure to apply a fix pack, where you stop one node at a time.

Procedure

1. Review the following settings in the <install>/properties/sandbox.cfg file
prior to applying a fix pack. Update them if needed. These settings govern
database updates:

* Node 1:
REINIT_DB=true
CLUSTER=true
* Node 2 and higher:
REINIT_DB=false
CLUSTER=true
2. Navigate to the IBM Fix Central web site.
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11.
12.
13.

14.

15.
16.
17.

18.

Download the most recent fix pack file for your version of Sterling B2B
Integrator and record the absolute path to the downloaded file. Do not
rename the file. If you use FTP, you must use Binary mode.

Verify that the database server is up and ready to accept connections.

Log in to the server where Sterling B2B Integrator is installed with the user ID
and password that was used for the installation.

Navigate to \install_dir\install\bin:

a. Click Start.
Right-click Command Prompt and select Run as administrator.
The Administrator: Command Prompt dialog box is displayed.

Enter StopWindowsService.cmd to stop the node. Wait until the perimeter
server of the node is completely down before installing the fix pack.

Perform a full backup of the Sterling B2B Integrator installation directory,
including all subdirectories.

Perform a back up of the database.

If you edited any property files, ensure that the associated properties.in files
have the most current changes. Property files will be overwritten with the
contents of the associated properties.in files during the fix pack installation.

Is the database password encrypted? If Yes, decrypt the password.
Close all command prompt windows.
Navigate to installation directory, using one of the following methods:
a. Click Start.
Right-click Command Prompt and select Run as administrator.
The Administrator: Command Prompt dialog box is displayed.

Enter: InstallService.cmd <path>\si_<version>_sp_0_fix
pack_<number>_<app_server>.jar

where:
<path> is fully qualified path to maintenance fix pack file
<version> is Sterling B2B Integrator version
<number> is fix pack number
<app_server> is Application server

If the fix pack attempts to modify the database schema and the modification
fails, you will receive an error message about the failure. The message will
provide the error message code from the database and the SQL command that
failed. The failure information is also logged to the system.log file (in the
install_dir\install directory) and to the fix pack.log file.

Attention: Running InstallService.cmd removes any previously installed
interim fix to prevent conflicts with what is being installed.

Press Enter to continue.
If you want to accept the license agreement, enter Y.
Enter the passphrase.

Information about the fix pack is displayed. After the fix pack has been
applied, the following message is displayed:

Deployment

to application server successful.

After you have completed the fix pack for node 1, you can now perform the

steps for node 2 and greater. For node 2 and greater, you must update the
value of REINIT_DB to false. When REINIT_DB is false, database updates are
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not applied during each fix pack. The REINIT_DB attribute is in the
\install_dir\install\properties\ sandbox.cfg file.

19. Repeat Steps 11 to 15 for each node.
20. If you decrypted the database password, re-encrypt the password.
21. Start Sterling B2B Integrator.

If you are using a perimeter server in the DMZ, you will to review the
information on apply a fix pack to the perimeter server.

Install an interim fix (Windows Cluster)
After you install Sterling B2B Integrator you may need to install an interim fix.

About this task
An interim fix is one or more fixes applied to a specific existing fix pack.

Before you can install an interim fix developed for your company, you must have
completed the following:

* Received the file name of the ccaseid jar to install from IBM Customer Support
* Created a full backup of Sterling B2B Integrator
* Created a full backup of your database

* Preserve your custom changes to system resources.
To install an interim fix in a Windows Cluster environment, starting with node 1:

Procedure
1. Log in to the computer that you are installing the interim fix on.

2. If the database password was encrypted, decrypt the password.

3. Navigate to the IBM Fix Central website.

4. Login using your email address and password.

5. Download the ccaseid.jar file, where ccaseid includes the ID number you
received from Customer Support. If you use FTP, you must use Binary mode.

6. Stop Sterling B2B Integrator.

7. Navigate to install_dir for the node (starting with node 1), using one of the
following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

8. Enter InstallService.cmd \absolutePath\ccaseid.jar to install an interim
fix.
You may need to complete this step twice depending on the fix pack. Read the
output from the InstallService script carefully to see if you need to complete
this step twice.

Attention: Running InstallService.cmd removes any previously installed
interim fix to prevent conflicts with what is being installed.

Windows Cluster Environment Installation (V5.2.3 - 52.5) 71



9. After you have completed an interim fix for node 1, you can now perform the
steps for node 2 and greater. For node 2 and greater, you must update the
value of REINIT_DB to false. When REINIT_DB is false, database updates are
not applied during each fix pack. The REINIT_DB attribute is in the
\install dir\install\properties\ sandbox.cfg file.

10. Repeat Steps 7 and 8 for each node.
11. If you decrypted the database password, re-encrypt the password.

12. For each node, navigate to the install_dir (starting with node 1) and start the
cluster, using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

* Open a command prompt window (from Complete the following steps:
the Run dialog box). » Click Start.

* Enter startCluster.cmd nodeNumber * Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.
* Enter startCluster.cmd nodeNumber

13. Start Sterling B2B Integrator.

14. Navigate to the install_dir\instal1\bin directory, run the dump_info
command to verify that an interim fix was successfully installed, using one of
the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

* Open a command prompt window (from Complete the following steps:

the Run dialog box). » Click Start.

* Enter dump_info.cmd * Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.
* Enter dump_info.cmd

Uninstalling an interim fix

Uninstalling an interim fix is a manual process. IBM support must first determine
what is included in the interim fix you want to remove, and then manually
backout the changes one at a time. The complexity of this process, therefore, can
vary greatly.

If you must remove an interim fix, contact IBM support by creating a PMR
(Problem Management Record)

DB Checksum tool

A checksum is a simple redundancy check used to detect errors in data.

In Sterling B2B Integrator, a verification process compares the checksum between
the existing default resource and the resource that was added after applying a fix
pack or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as
defaults.

72  Windows Cluster Environment Installation:



The DB Checksum tool generates the difference in resource checksum between the
default resource and the latest system resource from the database.

Perform a Checksum (Windows)
You can run the DB Checksum tool in the Windows environment.

About this task
To run the DB Checksum tool in the Windows environment:

Procedure

1. Navigate to \install_dir\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box).  Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter db_checksum tool.cmd [-d] [-i [1 | 2 | 3| 4 | 5]]1 [-r [wfd | map
| schema | sii | template]] [-o <output file>] [-g]

Where:

-d is the mode to dump the difference of resource checksum between the
default resource and latest system resource.

-1 is the resource type integer (optional).
1is WED.

2 is MAP.

3 is SCHEMA.

4 is SII.

5 is TEMPLATE.

-1 is the resource name (optional). For example, wfd, map, schema, sii, or
template.

-0 is the file name to output all the messages (optional).
-g is the file name that lists all the ignored resources (optional).
-h is the help screen.

The DB Checksum tool performs the relevant checksum operation based on the
command options and generates the output message.

Fix Pack Changes Report

The Fix Pack Changes Report is used to obtain information if you need to roll back
a fix pack.

The fix pack report can be found in the installation directory fix pack_reports
folder. The report contains the following fix pack information:

* Fix pack ID

* Fix pack changes

* Number of files deleted

* Number of JAR files removed
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* Number of JAR files added

* Number of files added

* Number of files changed

* Number of properties added

* Number of business processes added
* Number of service instances added

* Number of service definitions added
* Number of templates added

* Number of reports added

* Number of maps added

* Number of schemas added

* Number of business rules added

For example, the installation directory fix pack_reports folder contains the fix
pack_Report.html file. When you open this file, you can view the fix pack
information.

Example: Fix Pack Changes Report
The Fix Pack Changes Report includes both summary and detailed report
information.

The following is an example of a Fix Pack Changes Report:

Summary of Changes

Fix Pack ID: Platform_2.0

Fix Pack Changes: 1287

Number of Files Deleted: 0

Number of JARs Removed: 2

Number of JARs Added: 0

Number of Files Added: 3

Number of Files Changed: 3

Number of Properties Added: 4

Number of BPs Added: 4

Number of Service Instances Added: 2
Number of Service Definitions Added: 3
Number of Templates Added: 0

Number of Reports Added: 0

Number of Maps Added: 3

Number of Schemas Added: 3

Number of Business Rules Added: 0

List of JARs Removed:

JAR Removed: /SAMPLE_INSTALL 1/jar/jaf/1 0 2/activation.jar

Time: Wed May 13 15:23:08 EDT 2009

JAR Removed: /SAMPLE_ INSTALL 1/jar/commons logging/l 0 3/commons-logging-api.jar
Time: Wed May 13 15:23:08 EDT 2009

List of Files Added:

File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2_schema.sql

Time: Wed May 13 15:21:30 EDT 2009

File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2iseries_schema.sql
Time: Wed May 13 15:21:30 EDT 2009

File Added: /SAMPLE_INSTALL_1/bin/errorQueueManager.sh.in
Time: Wed May 13 15:21:30 EDT 2009

List of Files Changed:

File Changed: /SAMPLE_INSTALL 1/properties/lang/en/Reports_en.properties
File Changed: /SAMPLE_INSTALL 1/properties/lang/es/Reports_es.properties
File Changed: /SAMPLE INSTALL 1/properties/lang/fr/Reports_fr.properties
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List of Properties Added:

Property Added: /SAMPLE_INSTALL_1/properties/filesToRemove.txt
Property Added: /SAMPLE_INSTALL 1/properties/filesToRemove.txt.in
Property Added: /SAMPLE_INSTALL_1/properties/csr.properties.sample
Property Added: /SAMPLE_INSTALL_1/properties/csr.properties.sample.in

List of BPs Added:

BP Added: Schedule_AssociateBPsToDocs.bpml version: 4
Time: Wed May 13 15:23:07 EDT 2009

BP Added: Recovery.bpml version: 17

Time: Wed May 13 15:23:07 EDT 2009

BP Added: Schedule_AutoTerminateService.bpml version: 10
Time: Wed May 13 15:23:07 EDT 2009

BP Added: Schedule_DBMonitorService.bpml version: 1
Time: Wed May 13 15:23:08 EDT 2009

List of Service Instances Added:

Service Instance Added: RetentionProcessor version: 2
Time: Wed May 13 15:23:28 EDT 2009

Service Instance Added: MESAHttpServerAdapter version: 1
Time: Wed May 13 15:25:11 EDT 2009

List of Service Definitions Added:

Service Definition Added: LockServiceType
Time: Wed May 13 15:22:58 EDT 2009

Service Definition Added: XAPIServiceType
Time: Wed May 13 15:22:59 EDT 2009

Service Definition Added: CleanLockServiceType
Time: Wed May 13 15:22:59 EDT 2009

List of Templates Added:

Template Added: Normalize

Time: Wed May 13 15:23:26 EDT 2009
Template Added: Derive

Time: Wed May 13 15:23:26 EDT 2009

List of Maps Added:

Map Added: IBMPutResponseToXML
Time: Wed May 13 15:24:05 EDT 2009
Map Added: http_headers

Time: Wed May 13 15:24:36 EDT 2009
Map Added: OracleHttpHeaders

Time: Wed May 13 15:24:51 EDT 2009

List of Schemas Added:

Schema Added: E5_V20_Acknowledge Result.dtd from file: E5_V20_Acknowledge Result
Time: Wed May 13 15:24:36 EDT 2009

Schema Added: E5 V20 Acknowledge Submit.dtd from file: E5_V20_Acknowledge Submit
Time: Wed May 13 15:24:36 EDT 2009

Schema Added: E5 V20 APIs Result.dtd from file: E5 V20 APIs Result

Time: Wed May 13 15:24:36 EDT 2009

License modifications

After the installation finishes, you can modify the software licenses that you
loaded with the AddLicenseSet command.

The AddLicenseSet command is in the bin directory of your UNIX or Windows
installation. After the initial installation, the license files are in the following
directories:

e UNIX - /install dir/install/properties/Ticensefiles
* Windows - \install _dir\install\properties\licensefiles
* iSeries - /install _dir/properties/licensefiles
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You can add licenses or review the license list from the UL On the Administration
Menu, click System > B2B Console > Operations > System > Licenses.

AddLicenseSet Command Parameters

Use the AddLicenseSet command to modify a single license file or the entire license
file directory.

To use the AddLicenseSet command, you must do the following:
* Open the bin directory

* Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameter Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the

database before the new files are loaded. The old license

files are saved to the following locations:

* UNIX - /install_dir/install/logs/security/
old_licenses

* Windows - \install dir\install\logs\security\
old_licenses

* iSeries - /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following locations:

* UNIX - /install_dir/install/logs/security/upgrade
* Windows -\install_dir\instal1\logs\security\upgrade

* iSeries -/install_dir/logs/security/old_licenses

The AddLicenseSet command will check if Sterling B2B Integrator is running. If it
is running, the commond will call the Ops server to refresh the license from the
database. If you have any problems with your licenses after running the
AddLicenseSet command, stop and restart Sterling B2B Integrator.

License Modification: Examples
There are several different ways you can use the AddLicenseSet command to
modify your licenses.

UNIX Examples

From the install_dir/bin directory:

Scenario Command usage (UNIX example)

Reload a single license file ./AddLicenseSet.sh /install _dir/install/properties/
Ticensefiles/SI_SFG_License.xml -reload

Reload all of the license files |./AddLicenseSet.sh /install dir/install/properties/
in the directory licensefiles/ -reload
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Scenario Command usage (UNIX example)

Upgrade a single license file |./AddLicenseSet.sh /install_dir/install/properties/
Ticensefiles/SI_SFG_License.xml -upgrade

Upgrade all of the license ./AddLicenseSet.sh /install_dir/install/properties/
files in the directory Ticensefiles/ -upgrade

Windows Examples

From the install_dir\bin directory:

Scenario Command usage (Windows example)

Reload a single license file AddLicenseSet.cmd\install dir\install\properties\
Ticensefiles\SI_SFG_License.xml -reload

Reload all of the license files |AddLicenseSet.cmd\install _dir\install\properties\
in the directory Ticensefiles\ -reload

Upgrade a single license file |AddLicenseSet.cmd\install_dir\install\properties\
Ticensefiles\SI_SFG_License.xml -upgrade

Upgrade all of the license AddLicenseSet.cmd\install_dir\install\properties\
files in the directory Ticensefiles\ -upgrade

Configure Non-English Environment in Windows

Non-English Environment Checklist

You can install Sterling B2B Integrator in an English or a non-English environment.
The base language for the Configurator can be switched only once. Use the
following checklist change to a non-english environment:

# Non-English Environment Checklist Your Notes
Install the Sterling B2B Integrator Language Pack.

2 Load the Sterling B2B Integrator Language Pack
Factory Defaults.

3 Load the Sterling B2B Integrator Language Pack
translators.

4 Configure Encodings.

5 Configure Locales.

Language Settings in a Windows Environment
Language settings for Java applications involve both character sets and encoding;:

* A character set is a set of characters (letters, numbers, and symbols such as #, §,
and &) that are recognized by computer hardware and software.

* An encoding is a representation of data in a particular character set. An
encoding set is a group of encodings.

For information about basic and extended encoding sets, see IEttp: // |
[download.oracle.com /javase/1.5.0/docs/guide /intl / encoding.doc.html|

The default encoding set includes:
» UTF-8 (default)
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. 1S0-8859-1
. ISO-8859-5
« US-ASCII
« 1SO_8859-1
. EUCP

. UTF-16

« 1SO-2022-JP

Sterling B2B Integrator provides two property files that contain supported
encoding sets. These properties files reside in the \install_dir\install\properties
directory.

* encodings.properties — Contains the default encoding set used in the user
interface.

* encodings_large.properties — Contains all supported encoding sets.

You are not limited to the encodings in the encoding.properties file. Sterling B2B
Integrator enables you to configure the encodings properties files to expand the
number of encodings you can use.

Install the Language Pack (Windows)
About this task

Before installing the language pack be sure that you have successfully installed
Sterling B2B Integrator.

To install Sterling B2B Integrator language pack:

Procedure
1. Insert the language CDs into your CD-ROM drive.
2. Navigate to Win Directory using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

3. Run the setup.exe command.

Load the Language Pack Translations (Windows)
About this task

Prior to loading the Sterling B2B Integrator Language Pack factory defaults, be sure
that you have successfully completed all instructions in the database chapter.

To load the language pack translation with custom localization literals:
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Procedure

1.

Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2.

Run the LocalizedStringReconciler tool in the IMPORT mode, enter: ant.cmd
-f localizedstringreconciler.xml import -Dsrc=install_dir\database\
FactorySetup\XMLS

This tool first inserts the value specified in the
<from_language>_<from_country>_ycplocalizedstrings_<to_language>_
<to_country>.properties file present in the install_dir\database\FactorySetup\
XMLS\<language>_<country> directory into the database.

The basefilename refers to the file present in the \database\FactorySetup\
XMLS directory, for which the translations are to be imported into the database.

Verify that your locale settings such as currency, time format, and date are
correct.

Configure Encodings for Sterling B2B Integrator (Windows)
About this task

To configure your encoding set:

Procedure

1.
2.

Stop Sterling B2B Integrator and wait for shutdown to complete.
Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

oo bk w

Open the encodings_large.properties file.
Select the encodings you want to add to the encodings.properties file.
Open the encodings.properties.in file.

At the end of the encodings.properties.in file, add the encodings you selected
from the encodings_large.properties file. When adding encodings from one file
to the other, first copy the encodings as they appear in the
encodings_large.properties file. After adding the new encodings, ensure that
the index numbers are consecutive. If the index numbers are not consecutive,
change the index number or numbers as needed. For example, encoding54
cannot follow encoding6. In this example, change encoding54 to encoding?.

The first name in the definition (before the comma) is the name that will
appear in the Sterling B2B Integrator user interface. You can change this name
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to make it more descriptive. For example: encoding4 = 819,ISO8859_1 may be
changed to encoding4 = WesternEurope,ISO8859_1. ISO8859_1 is the Java
canonical name and should not be changed.

7. Update the first line in the encodings.properties.in file (numberof). Change
numberof to the number of encodings added to the file. For example, if the
current value is numberof = 6 and you add 5 new encodings, the new value is
numberof = 11.

numberof indicates the total number of encodings located in the file. You must
update numberof to ensure that the encodings you added will be visible in the
user interface.

8. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

9. Enter setupfiles.cmd.
10. Start Sterling B2B Integrator.

Configure Locales (Windows)
About this task

Sterling B2B Integrator runs in any locale that Java supports. If you want to run in
a non-default locale, then configure your environment to the specific locale you
want to use.

To determine and set your locale in a windows environment:

Procedure

1. Select Control Panel > Regional Options > General.

2. From the Your locale (location) list, select the language and location.

3. Click Set Default and select the locale from the Set the appropriate locale list.
4

. To configure your operating system as a non-English environment, consult your
operating system's documentation.

Load the Language Pack Factory Defaults (Windows)
About this task

To load the language-specific factory defaults, use the loadDefaults.cmd script
available in the install_dir\instal1\bin directory and pass the locale-specific
installer file.

For example:

ToadDefaults.cmd \install_dir\install\database\FactorySetup\install\
<language>_<country> locale_installer.xml

The default locale that is shipped with the CD is ja_JP.
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Configure Browser Settings for a Foreign Language

Configure Browser Settings

Some browsers and/or operating systems require additional configuration in order
to correctly render the Sterling B2B Integrator user interface in certain languages.
Use the procedures provided in this section to properly configure a browser to
display the Sterling B2B Integrator user interface in the appropriate language.

Note: If your browser is unable to display the user interface properly or you see a
mixture of English and another language, this is an indication that the browser is
configured incorrectly. You may also need to install additional fonts on the Sterling
B2B Integrator server.

Support for foreign languages

The Sterling B2B Integrator 5.2.3 user interface includes support for several foreign
languages

Attention: Sterling B2B Integrator 5.2.3 product code is designed to work with
Latin based English only input. The use of any other type of input might have
uncertain results and is not supported as part of the 5.2.3 release.

The Sterling B2B Integrator 5.2.3 user interface includes support for the following
foreign languages:

* French

* German

 Italian

* Japanese

* Korean

* Polish

* Portuguese (Brazilian)
* Simplified Chinese

e Traditional Chinese

Four of these languages involve expanded Unicode character sets:
* Japanese

* Korean

* Simplified Chinese

* Traditional Chinese

The implementation of these languages in your environment might require the
addition of new Unicode fonts on your server:

If... then...

Sterling B2B Integrator is on a server that You do not need to install any additional
already supports these languages fonts.

You are installing on a server that is only You need to have the fonts for these

setup for the Latin alphabet and you have |languages installed.
users who need to view the Sterling B2B
Integrator user interface in any of the Asian
languages
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Add a

A way to test the implementation of a language is to create a user with one of the
new languages and setup their browser to use that language as it's primary
language. Log in to the system and review the user interface. If you see a mixture
of English and the new language, your configuration is not correct. You need to
verify that the browser is set up correctly and review the fonts that are installed on
the server.

The installation of more fonts/languages on the server should be done in
coordination with your technical support team. Be sure to include a Unicode Sans
Serif font on your server.

Important: While multiple foreign languages are supported, a user account should
be configured to use one specific language to avoid user interface display issues.

Custom Language Preference Code
About this task

In order for your browser to display the Sterling B2B Integrator user interface and
address bar text correctly in a foreign language, you must specify the appropriate
language preference code for the browser.

Sterling B2B Integrator 5.2.3 supports the following language preference codes:
s de

* en

* en-US
* es

s fr

e it

. ja

* ko

* pt-BR
* zh

e zh-TW

Your browser must be configured to use one of these specific language preference
codes to view the Sterling B2B Integrator user interface.

Note: Most browsers provide a default listing of language preference codes.
However, Sterling B2B Integrator requires the use of the specific codes as listed
here. For example, you cannot use the default German (Germany) [de-DE], you
must use [de].

You may need to add these supported codes as a custom language preference code
in your browser.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an IE
window.
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Procedure

Open an IE browser window.

Select Tools > Internet Options.

At the bottom of the window under Appearance, click Languages.
Click Add to display the Add Language window.

In the User defined: text box, enter the appropriate language preference code
from the list below:

* de
* en
* en-US
* es
o fr

e it

ok~ wnp =

. ja
* ko
* pt-BR
* zh
* zh-TW

6. Click OK. The added code should display in the Language: listing in the
Language Preference window. An example entry would be, User Defined

[del.

7. (Optional) Move the added language up to be the first one listed if there are
multiple languages listed.

a. Select the newly added language.
b. Click Move up.
The newly added language should now appear first in the Language
listing.
8. Click OK to save your Language Preference settings.
9. Click OK to close the Internet Options window.
10. Close your browser window.

11. Open a new browser window and access the Sterling B2B Integrator user
interface to verify your changes have been applied.

Change Default Browser Font
About this task
Some languages require the use of special fonts to properly display the Sterling
B2B Integratoruser interface. The client computer must be configured to display
these types of fonts. Each Windows client must be configured appropriately.
Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on

configuring that browser’s display.

The following is an example of how to change the default browser font for an
Internet Explorer (IE) window.

To configure a client machines display for IE:
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Procedure

1. Determine which fonts are needed to support your needed language and
verify they are installed on the server.

Note: The installation of additional fonts/languages on the server should be
done in coordination with your technical support team. Be sure to include a
Unicode Sans Serif font on your server.

Open an IE browser window.
Select Tools > Internet Options.

At the bottom of the window under Appearance, click Fonts.

ok wn

From the Language Script drop-down menu, change the Latin based value to
the appropriate script for your needed language.

Note: If your encoding is not available, you may need to install a new
version of Internet Explorer, but make sure you install the appropriate
international options.

6. Select a Webpage font and a Plain text font appropriate for the new language.
A Plain text font is one in which all the characters take up the same amount
of space and is associated with older computer terminals.

Note: If no fonts are listed in the menus, then you need to install fonts
designed for that encoding.

7. Click OK to close the Fonts window.
8. Click OK again to close the Internet Options window.
9. Close your browser window.

10. Open a new browser window and access the Sterling B2B Integrator user
interface to verify your changes have been applied.

Set the Client Character Display
About this task

To use special characters, such as for various languages, the client computer must
be configured to display these types of characters. In order for Unicode characters
to display correctly in the application, each Windows client must be configured
appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on

configuring that browser’s display.

The following is an example of how to configure a client machine display for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure
1. Open an IE browser window.
2. Select View > Encoding > Auto-Select.
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Clearing Browser and Java Plugin Caches Before Initial
Deployment
About this task

Once the Sterling B2B Integrator is ready for deployment, each user must clear the
browser and Java Plugin caches on their client machines before launching Sterling
B2B Integrator. This requirement applies to all browsers.

To clear the browser and java caches, do the following:

Procedure
1. From the browser menu bar, select Settings > Control Panel > Internet
Options.

2. Select the General tab, and in the Temporary Internet Files panel, click Delete
Files. The Delete Files dialog displays.

3. Check the Delete All Offline Content checkbox. Click OK until the Internet
Properties window closes. The browser cache is cleared.

4. From the Windows start menu, select Settings > Control Panel > Java.

5. Select the General tab, and in the Temporary Internet Files panel, click Settings.
The Temporary Files Settings dialog displays.

6. In the Disk Space panel, click Delete Files. The Delete Temporary Files pop-up
window displays.

7. Click OK until the Java Control Panel window closes.

General Internet Explorer Browser Settings

When using Sterling B2B Integrator without any customizations, you need to set
the General Browser settings for your Internet Explorer in order to obtain the best
browser performance.

Note: This can impact the display of reports and search listings.

To set your general browser settings:

1. From the Internet Explorer menu, select Tools > Internet Options.
The Internet Options window opens to the General tab.

2. Locate the Browsing history section and click Settings.
The Temporary Internet Files and History Settings window opens.

3. Below Check for newer versions of stored pages: select the Everytime I visit
the webpage option.

4. Click OK to save your changes.

o

Click OK to apply the changes.
6. Close the browser window and re-open it.

The browser is now set to check for updates to pages everytime a page is
accessed rather than relying upon a cached version.

Internet Explorer Security Settings
About this task

When using Sterling B2B Integrator without any customizations, you need to set
security settings for your Internet Explorer to obtain the best browser performance.
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To configure the Internet Explorer security and privacy settings:

Procedure

1. From the Internet Explorer menu, select Tools > Internet Options.

2. Click the Security tab.

3. Select the Web content zone from which Sterling B2B Integrator is accessed.

4. Set the security level to Medium-low.

5. Click Custom Level and set your security settings according to the following
table:

Internet Explorer Security Setting | Sterling B2B Integrator

.NET Framework

Loose XAML Enable

XAML browser applications Enable

XPS documents Enable

.NET Framework-reliant Components

Permissions for components with manifests High Safety
Run components not signed with Authenticode Enable
Run components signed with Authenticode Enable

ActiveX Controls and Plugins

Allow previously unused ActiveX controls to run | Enable
without prompt

Allow Scriptlets Enable
Automatic prompting for ActiveX controls Enable
Binary and script behaviors Enabled
Display video and animation on a webpage that Disable
does not use external media player

Download signed ActiveX controls Prompt
Download unsigned ActiveX controls Prompt

Initialize and script ActiveX controls not marked as | Prompt
safe for scripting

Run ActiveX controls and plugins Prompt/Enable

Script ActiveX controls marked as safe for scripting | Enable

Downloads

Automatic prompting for file downloads Enable

File download Enable

Font download Prompt
Enable .NET Framework setup Enable

Java VM

Java permissions Medium safety
Miscellaneous

Access data sources across domains Enable

Allow META REFRESH Enable

Allow scripting of Internet Explorer web browser Enable
control
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Internet Explorer Security Setting

Sterling B2B Integrator

Allow script-initiated windows without size or
position constraints

Enable

Allow webpages to use restricted protocols for Prompt
active contents

Allow websites to open windows without address | Enable
or status bars

Display mixed content Prompt
Do not prompt for client certificate selection when |Enable
no certificates or only one certificate exists

Drag and drop or copy and paste files Prompt
Include local directory path when uploading files | Enable
to a server

Installation of desktop items Prompt
Launching applications and unsafe files Prompt
Launching programs and files in an IFRAME Prompt
Navigate sub-frames across different domains Enable
Open files based on content, not file extension Enable

Software channel permissions

Medium safety

Submit non-encrypted form data Prompt
Use Phishing Filter Disable
Use Pop-up Blocker Disable
Userdata persistence Enable
Websites in less privilged web content zone can Prompt
navigate into this zone

Scripting

Active scripting Enable
Allow Programmatic clipboard access Prompt
Allow status bar updates via script Enable
Allow websites to prompt for information using Enable
scripted windows

Scripting of Java applets Enable

User Authentication

Logon

Prompt for user name and password

6. Click OK to save your settings.

7. Click OK to save the new settings and Apply to implement the settings. The

new settings are applied when a new browser window is opened.

Perimeter Server Installation

Perimeter Server Overview

A perimeter server is an optional software tool for communications management.
A perimeter server can be installed in a demilitarized zone (DMZ). A DMZ is a
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computer host or small network inserted as a neutral zone between a company's
private network and their public network. A perimeter server requires a
corresponding perimeter client.

The perimeter server manages the communications flow between outer layers of
your network and the TCP-based transport adapters. A perimeter server can solve
problems with network congestion, security, and scalability, especially in
high-volume, Internet-gateway environments.

Installation Guidelines for Perimeter Servers with Sterling B2B
Integrator

The installation program installs a perimeter client and a local mode server. The
local mode server is useful for testing purposes or in environments that do not
require a secure solution. However, if you require high-volume, secure connections,
you must install a perimeter server in a remote zone, either a more secure or less
secure network than your integration server.

Consider the following before you install a perimeter server:

* Licensing for a perimeter server is determined by the licensing restrictions on
the corresponding B2B adapters.

* Each perimeter server is limited to two TCP/IP addresses:

— Internal interface is the TCP/IP address that the perimeter server uses to
communicate with Sterling B2B Integrator.

— External interface is the TCP/IP address that the perimeter server uses to
communicate with trading partners. To use additional TCP/IP addresses,
install additional perimeter servers.

* You can have multiple perimeter servers installed on the same computer
interacting with one instance of Sterling B2B Integrator. To install a perimeter
server on a computer with an existing instance, install the new perimeter server
in a different installation directory.

* The combination of internal TCP/IP address and port must be unique for all
perimeter servers installed on one computer.

— If a perimeter server is installed using the wildcard address, then all ports
must be unique. The assigned ports are not available for use by adapters that
use the server or any other perimeter server on that computer.

— The internal and external interface may use the same TCP/IP address.
However, the port used by the perimeter server is not available to the
adapters that use the server.

Perimeter Server Installation Methods

You can install perimeter server either in silent mode or in interactive mode. The
default installation mode is silent. In the silent mode, you should specify the
details in a silent file, whereas in the interactive mode, you should enter the value
each time a prompt appears.

Perimeter Server Information Gathering Checklist

Before you install the perimeter server, you need to gather the following
information and answer the following questions:

Perimeter Server Information Gathering
Checklist Your Notes

Path to java
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Perimeter Server Information Gathering
Checklist Your Notes

Path to the Sterling B2B Integrator
installation directory

Wil this perimeter server be installed in a
less secure network?

TCP/IP address or the DNS address that the
perimeter server will listen on.

Listening port for the perimeter server.

Local port that the perimeter server will use
to connect to Sterling B2B Integrator.

Port number must be higher than 1024.

Installing a perimeter server in a less secure network
(Windows)
About this task

Install a perimeter server in a Windows environment in interactive mode.

Procedure
1. Close all open Windows programs.

2. Copy the jar installation files from the installation media to a Windows
directory. If you are using FTP to copy the file, make sure that your session is
set to binary mode. The jar installation file names are as follows:

* For 5.2.3 the file is named ps_4060300.jar
* For 5.2.4 the file is named ps_4060400. jar
3. To start the perimeter server installation, use one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later
* From a command prompt (or from the * Click Start.
Run dialog box), enter the following * Right-click Command Prompt and select

command: Run as administrator.

\path_to_java\java -jar
\install_dir\install\packages\
ps_filename.jar —interactive

The Administrator: Command Prompt
dialog box is displayed.

* Enter the following command:\
path_to_java\java -jar
\install dir\install\packages\
ps_filename.jar —interactive

The installation program verifies the operating system, minimum fix pack
level, and the location and version of the JDK.

4. Enter the full path name of the installation directory.

5. If there is an existing installation in the directory you specify, you can update
it using the same settings. Answer the question:

There is an existing install at that location, update it while keeping
existing settings?

If yes, the installation proceeds without more entries.

Note: If you want to change any of the settings, you must use a new
directory, or delete the old installation before you reinstall the perimeter
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10.
11.

12.
13.

14.

15.
16.

server. You cannot overwrite an existing installation, and you cannot use an
existing directory that does not contain a valid installation. The existing
installation must be Sterling B2B Integrator 5.2 or later.

Confirm that the installation directory is correct.

The program verifies the amount of available disk space.

Answer the question:

Is this server in a less secure network than the integration server?
Yes

Answer the question:

Will this server need to operate on specific network interfaces?

If yes, the program returns a list of the network interfaces available on your
host. Select the interfaces for the server to use.

Enter the TCP/IP address or DNS name for the internal interface to use to
communicate with the integration server (Sterling B2B Integrator). Press Enter
to use a wildcard for this address.

Verify the TCP/IP address or DNS name for the internal interface.

Enter the TCP/IP address or DNS name for the external interface to use to
communicate with trading partners. Press Enter to use a wildcard for this
address.

Verify the TCP/IP address or DNS name for the external interface.

Enter the port that the perimeter server listens on for the connection from the
integration server (Sterling B2B Integrator). The port number must be higher
than 1024.

Verify the port.

When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

Change to the installation directory.

Enter startupPs.cmd to start the perimeter server.

Installing a Perimeter Server in a More Secure Network
(Windows)

Install a perimeter server in a more secure network in a Windows environment in
interactive mode.

Before you begin

Sterling B2B Integrator must be installed.

* Complete the Perimeter Server information gathering checklist.

Procedure

1. Close all open Windows programs.

2. Copy the jar installation files from the installation media to a Windows
directory. If you are using FTP to copy the file, be sure that your session is set
to binary mode. The jar installation file names are as follows:

* For 5.2.3 the file is named ps_4060300.jar
* For 5.2.4 the file is named ps_4060400.jar
3. To start the perimeter server installation, use one of the following methods:
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For Windows Server 2003 or earlier For Windows Server 2008 or later

From a command prompt (or from the * Click Start.
Run dialog box), enter the following .

Right-click Command Prompt and select
command:

Run as administrator.
\path_to_java\java -jar
\install _dir\install\packages\
ps_filename.jar —interactive

The Administrator: Command Prompt
dialog box is displayed.

* Enter the following command:\
path_to_java\java -jar
\install _dir\install\packages\
ps_filename.jar —interactive

The installation program verifies the operating system, minimum fix pack
level, and the location and version of the JDK.

Enter the full path name for the Sterling B2B Integrator installation directory
and press Enter.

If there is an existing installation in the directory you specify, you can update
it using the same settings. Enter yes, and the installation proceeds without
more entries.

Enter yes to confirm that the installation directory is correct.

The program verifies the amount of available disk space.

Answer the question:

Is this server in a less secure network than the integration server?
Yes

Answer the question: Will this server need to operate on specific
network interfaces?

* Enter yes to select from a list network interfaces available.
* Enter no.

Enter the TCP/IP address or DNS name that the integration server listens on
for the connection from this perimeter server.

Enter yes to confirm the TCP/IP address or DNS name.

Enter the port that the integration server listens on for the connection from
this server. The port number must be higher than 1024.

Enter the local port number that the perimeter server uses for the connection

The port number must be higher than 1024. Specify a port of zero for the

1.

to the integration server.

operating system to select any unused port.
12. Enter yes to confirm the port number.

After the installation is complete, the following messages are displayed:
Installation of Perimeter Service is finished

To start this Perimeter Server change to the install directory and run
the startup script.

You will also need to configure this server in your integration server
(SI) uI.

Silent Installation Method for an External Perimeter Server

You can install an external perimeter server using a silent install file. The perimeter
server can be installed on the same machine where you have installed Sterling B2B
Integrator or on a separate machine. It is recommended to install the perimeter

server on an separate machine.
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To use the silent installation method, you first create the silent install file and then
you use to complete the installation.

Create the Silent Installation File for an External Perimeter Server
About this task

Create a silent installation file with the following variables:

Entry Description

INSTALL_DIR (Required) The installation directory that stores perimeter server
files and related directories. This directory must exist prior to
running the silent install.

REVERSE_CONNECT | (Optional) Determines if the perimeter server is to be installed in a
more secure network zone. Valid values:

* Y - more secure network zone

* N - less secure network zone

PS_PORT (Required) Determines the perimeter server port to interact with
the system.
PS_SECURE_IF (Required) Determines the TCP/IP address or DNS name for the

internal interface to communicate with the integration server
(Sterling B2B Integrator). You can use a wildcard (*) for this
address.

PS_EXTERNAL_IF (Required) Determines the TCP/IP address or DNS name for the
external interface to communicate with the trading partners. You
can use a wildcard (*) for this address.

REMOTE_ADDR (Optional) Determines the remote perimeter server address.

(Not required if REVERSE_CONNECT=N)
REMOTE_PORT (Optional) Determines the remote perimeter server port.

(Not required if REVERSE_CONNECT=N)

MAX_JVM_HEAP (Required) Determines the maximum Java heap size allocated to
the JVM.

Installing an external perimeter server with a silent installation
file (Windows)

Install an external perimeter server with a silent installation file.
About this task

Before you begin, create the silent installation file.

Procedure
1. From the installation media, copy SI.jar to a Windows directory.
2. Set up your silent installation file and record the file location.

3. To start the perimeter server silent installation, use one of the following
methods:
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For Windows Server 2003 or earlier For Windows Server 2008 or later

* From a command prompt (or from the * Click Start.
Run dialog box), enter the following * Right-click Command Prompt and select
command: Run as administrator.
\Rath_tO_j clrva\]'ava -Xmx512m -jar The Administrator: Command Prompt
\install_dir\install\packages\ dialog box is displayed.

il .jar =f silent.txt
ps_filename.jar stient.tx * Enter the following command:\

The jar installation file names are as path to_java\java -Xmx512m -jar
follows: \install_dir\install\packages\
— For 5.2.3 the file is named ps_filename.jar —f silent.txt
ps_4060300. jar The jar installation file names are as
— For 5.2.4 the file is named follows:
ps_4060400.jar — For 5.2.3 the file is named

ps_4060300. jar

— For 5.2.4 the file is named
ps_4060400.jar

The installation program verifies the operating system, minimum fix pack level,
and the location and version of the JDK.

The installation starts. You can follow the progress of the installation on screen.
When the installation is finished, the system displays the following message:
Installation has completed successfully.

Install a Fix Pack in a Remote Perimeter Server (Windows)
About this task

Remote perimeter servers are not automatically updated by a fix pack. You must
reinstall the perimeter server using the new perimeter server installation file
supplied with the fix pack.

To update a Remote Perimeter Server:

Procedure

1. Update your installation with the latest fix pack. Obtain the fix pack from the
Support Center web site.

2. Locate your perimeter server file in the install_dir\install\packages directory of
your installation. For fix packs, obtain the file from the Support Center web
site. These files have a name that identifies a version number. For example,
ps_2006 jar.

3. Copy the file to a directory on the remote server.
4. Stop the perimeter server.
5. Use one of the following methods to install the fix pack:
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For Windows Server 2003 or earlier For Windows Server 2008 or later

* From a command prompt (or from the Click Start.

Run dialog box), enter the following * Right-click Command Prompt and select
command: Run as administrator.

\qbsolutef’ath\t?i n\java . -Jar The Administrator: Command Prompt
filename.jar -interactive dialog box is displayed.

* Enter the following command:\
absolutePath\bin\java -jar
filename.jar -interactive

Where the absolutePath is the directory name
where the Java version is installed.

Where the absolutePath is the directory name
where the Java version is installed.

The program verifies the operating system, required patch level, and the
location and version of the JDK.

6. Enter the full path to the installation directory. If you do not want to change
any settings for your perimeter server, specify the same directory where the
remote perimeter server was originally installed.

7. Answer the question:

There is an existing install at that Tocation, update it while keeping
existing settings?
If yes, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory,
or delete the old installation before performing the new installation. You cannot
overwrite an existing installation, and you cannot use an existing directory that
does not contain a valid installation. The existing installation must be

https:/ /apps.na.collabserv.com /meetings/join?id=4789-1289 5.2 or later.

When the perimeter server is installed, the following message is displayed:
Installation of Perimeter Service is finished

8. Change to the installation directory.

9. Start the perimeter server.

Grant Permissions for Specific Activities for a Perimeter
Server
About this task

Before you begin:
* Remote perimeter server must be installed for a more secure zone.
* Know what permissions you want to grant

* Understand the content of the restricted.policy file. The first two grant sections
in the restricted.policy file are required for correct perimeter server operation.
Do not modify these sections.

Procedure

1. Install a remote perimeter server, choosing the option for a more secure
network zone.

2. At the installation prompt Is this server in a less secure network than the integration
server?, select No, which is the option for a more secure network zone.

3. Navigate to the perimeter server installation directory.
4. Open the restricted.policy file.
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5. Add permission lines for each back-end server that you intend to allow the
proxy to access. There are commented out examples for each type of server.

The first two grant sections are required for correct perimeter server operation.
Do not modify these sections.

For example, you can grant permission to a target FTP Server. In the example,
servers are configured to listen on the following ports: 33001 (for FTP), 33002
(for HTTP), and 1364 (for C:D). These port numbers can be edited.

// To restrict or permit the required Host/Server to communicate with the

PS, update the "ftphost/htttphost/snode" with that of the Server IP and
provide the appropriate PORT number where the Server will listen. //

// For each target FTP Server

// permission java.net.SocketPermission "10.117.15.87:33001", "connect"; //
Control connection.

// permission java.net.SocketPermission "10.117.15.87:1owPort-highPort",
"connect"; // Passive data connections.

// 10.117.15.87 indicates IP of the FTP Server for which the permission is
granted by PS for communicating with client //

// For each target HTTP Server

//

// permission java.net.SocketPermission "10.117.15.87:33002", "connect";

// 10.117.15.87 indicates IP of the HTTP Server for which the permission

is granted by PS for communicating with client //

// For each target C:D snode
/1l
// permission java.net.SocketPermission "snode:1364", "connect";
// 10.117.15.87 indicates IP of the Connect Direct Node for which
the permission is granted by PS for communication //
6. In the perimeter server installation directory, there is the perimeter server
settings file called remote_perimeter.properties. Edit it to change the "restricted"
setting to a value of true to turn on restrictions.

7. In the future, any attempt by the perimeter server to access disallowed network
resources will be rejected and logged in the perimeter server log written to the
perimeter server installation directory.

Perform DNS Lookup on Remote Perimeter Server
About this task

By default, a perimeter server performs DNS lookup in the main server JVM. If
you have limited DNS in your secure area, you can configure the remote perimeter
server to look up trading partner addresses in the DMZ.

To enable DNS lookup, add the following property to
customer_overrides.properties. Set the value to true:

Property Name Description

perimeter.*. forceRemoteDNS=true Forces resolution of DNS names at remote
perimeter server.

Set the value to true to configure remote
perimeter servers to look up trading partner
addresses.

Start Perimeter Servers (Windows)
About this task

To start a perimeter server in Windows:
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Procedure
1. Navigate to the perimeter server installation directory.

2. Navigate to perimeter server installation directory using one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). o Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

3. Enter startupPs.cmd.

Stop Perimeter Servers in (Windows)
About this task

To stop a perimeter server in Windows:

Procedure

1. Navigate to perimeter server installation directory using one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter stopPs.cmd.

Uninstall the Software

Uninstall Sterling B2B Integrator from a Windows Cluster
Environment

When you uninstall Sterling B2B Integrator, Sterling B2B Integrator is automatically
removed from the server.

Before you begin

If you have installed Sterling B2B Integrator software using IIM, then perform
these steps to unregister Sterling B2B Integrator packages from the IIM registry:

e Launch IIM.

* Click Uninstall and select the required Sterling B2B Integrator package (Media,
FixPack, or Interim Fix).

¢ Confirm and click Uninstall.
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About this task

To uninstall Sterling B2B Integrator from a Windows environment, perform the
following steps for each node:

Procedure
1. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter StopWindowsService.cmd. Wait for the shutdown to complete. If you begin
removing files before all business processes and the system is stopped, you
may be unable to remove the software successfully.

3. Enter uninstallWindowsService.cmd to uninstall Sterling B2B Integrator
Windows Services.

4. Back up the file system and database.

This step is optional. However, by backing up the file system and database,
you are ensured that Sterling B2B Integrator is completely recoverable.

5. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rd /s /q \install_dir\install

6. If you use an Oracle, Microsoft SQL Server, or DB2 database, these remain
intact even after you remove Sterling B2B Integrator from the server. If you no
longer want to reference the data, contact your database administrator about
removing unwanted tables and recovering the database space where Sterling
B2B Integrator used to reside.

7. Navigate into the _uninst subdirectory of your JDK installation directory using
one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008 or later

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

8. To manually remove the JDK, enter uninstall.cmd.

9. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop, including the
following:

* Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

* Graphical Process Modeler

Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.
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* Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web
Template Designer.
* (If licensed) MESA Developer Studio plug-ins, including:
— MESA Developer Studio Software Development Kit (SDK)
— MESA Developer Studio Skin Editor

Refer to the MESA Developer Studio guide for information about removing
MESA Developer Studio.

* (If licensed) Reporting Services, which requires MESA Developer Studio if
you want to use the plug-ins to create fact models and custom reports. Refer
to the MESA Developer Studio guide for information about removing
Reporting Services.

User Documentation

Sterling B2B Integrator user documentation

The user documentation is available from an online documentation site on the
web.

Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

If you need a printed copy of the documentation, you can print topics of
information through your Internet browser, or you can download documents in
PDF format, after you add it to a collection on IBM Knowledge Center.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the help @ icon. The system must reside on a computer that supports
Internet access and an Internet browser.

Improving your access to online documentation

You can improve your access to online documentation by using several methods.
About this task

After you access the IBM Knowledge Center, you can perform the following tasks:
* Enter a word or phrase and search the entire library for information.

* Move through a hierarchy of contents pages to identify the topic you want to
read or print.

* Print topics by using your browser's Print function.
* Add documents to your collection and download them in PDF format.

Request a Documentation CD

You can request a CD that contains all the documentation found on the
Documentation site. To submit a request, open a support case.
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Troubleshooting Tips for Windows

Troubleshooting Tips for Windows Environment

You might encounter errors or problems that you can troubleshoot in a Windows

install.

environment.
Situation Message or Symptom Explanation/Resolution
Installing You encounter errors or problems during Explanation
installation.
The installation creates several log files that
you can use to diagnose problems like the
failure of an installation.
Resolution
Examine the log files generated during
installation:
* ant.install.log (in the install_dir directory)
* install_dir\PrelnstallSI.log
Installing When you entered an absolute path during |Explanation
installation, a message indicated that the
command was not found. You entered an incorrect path. Check the
information entered.
Resolution
Enter the correct path.
Installing IM is installed successfully, but SI Fails to Go to Start Open IM select Help and then

Export logs to a file for analysis.

Installing a desktop
tool or resource

Cannot download any of the following;:

* Map Editor and associated standards

* Graphical Process Modeler

* Web Template Designer

* (If licensed) MESA Developer Studio
plug-ins, including:
— MESA Developer Studio Software

Development Kit (SDK)

— MESA Developer Studio Skin Editor

* (If licensed) Reporting Services, which
requires MESA Developer Studio if you
want to use the plug-ins to create fact
models and custom reports.

Explanation

When you install Sterling B2B Integrator,
system files are created that contain an
internal IP address. If you install Sterling
B2B Integrator behind a firewall, and your
firewall is configured to accept an external IP
address from a client computer, you may not
be able to download the desktop tools and
resources. The firewall will reject the internal
IP address from a client residing outside of
the firewall.

Resolution

Modify the system files that contain the
invalid IP address. Follow these steps:

1.
2.
3.

Navigate to \install_dir\install\bin.
Stop Sterling B2B Integrator.

Enter the following command followed
by the external IP address:

patchJNLP.cmd external IP_address

Restart Sterling B2B Integrator.
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Situation

Message or Symptom

Explanation/Resolution

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the
activemgbroker.log:

sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target

Resolution

Add the system certificate to the trust store
using the KeyTool command.

Cluster Installation or
Upgrade

When configuring TCPS the following
warning can be found in the

Resolution

Oracle Add Constraint
Error

are using an Oracle database, if the upgrade
fails with the error message name is already
used by an existing object, this occurs
because the default behavior for the drop
constraint command changed in Oracle 10.

activemgbroker.log: Do not mention any SSL cipher in the
ActiveMQconfig.xml.
Do not mention any
SSL cipher in the ActiveMQconfig.
xml. oracle.net.ns.NetException:
Invalid cipher suites specified.
e-Invoice Upgrade: When you upgrade Sterling e-Invoicing and | Explanation

The index that is used to support the
constraint is now only removed if the index
was generated by the create constraint
command. The indexes for Sterling
e-Invoicing are always generated from
constraints during an install. If you receive
this error during a Sterling e-Invoicing
upgrade, it is because of how the database
was restored, the version of Oracle you are
using, and because the Oracle imp command
exported the indexes and constraints
separately. There is no way to determine
when the imp command will not add a
create index command to the export file if it
was generated by a constraint — but if it does
add the command, the database restore
process loses the association of the constraint
and its underlying index. The database script
that runs during a Sterling e-Invoicing
upgrade executes two steps: 1. First, it drops
the unique constraint so the next step can
redefine it using additional columns.
However, the drop constraint command does
not remove the underlying index if the
association with its index was lost. 2. The
next command that redefines this constraint
requires a different index definition, but in
this scenario the name of the index the
constraint wants to use already exists, which
causes the name is already used by an
existing object error.

Resolution

If you receive this error message, the
solution for this problem is to drop the index
and rerun the Sterling e-Invoicing upgrade.
The drop index command you should use is:
drop index UNQ EINV_CANON
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Situation Message or Symptom Explanation/Resolution

Apply a fix pack or The \install_dir\install\installed_data |Explanation

Upgrade directory is created (if clustered, on each
node) during an upgrade or applying a fix The information in this directory is used
pack. during upgrade or applying a fix pack, but is
not required afterward. The
This directory can become very large and deployment/cleanup tasks for the upgrade
take up needed space on the file system. or fix pack do not remove this directory.
Resolution

The directory can be manually removed to
increase the available space for the file

system:
1. Navigate to \install_dir\install
2. Enter

rd /S installed_data

3. If prompted to confirm deletion, enter Y
for yes.
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Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBMproducts.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,

modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must
include a copyright notice as shown in the next column.

© 2015.
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2015.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml|

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.
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Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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